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User guide 

Introduction to DxO Optics Pro 

About DxO Optics Pro 6.6 
Like some other photo processing programs, DxO Optics Pro v6.6 improves your photos. But 
we improve them more, and better, than any other software. And we improve them 
automatically. We‘ll explain why. 
  
First you should know briefly who we are. Our name is DxO Labs, we are based in Paris 
(France) and our chief scientists regularly publish scientific papers in the most prestigious 
journals of the computer image community. This scientific and mathematical background has 
allowed us to design DxO Optics Pro v6.6 as a tool that aims not just to improve quality, but to 
achieve perfection — and more specifically, automatic perfection.   
  

We have tested your camera and each of your lenses 

Our first unique feature is to test all the hardware characteristics in our own labs. Cameras and 
lenses spend days in the hands of our technicians, who measure not only optical defects like 
distortion, lens softness or vignetting, but also check and measure noise, colorimetry, and tone 
curves. They analyze the in-camera processing that is applied (with or without your knowing) to 
the images. The result is a huge database that has no equivalent anywhere in the world. This is 
what enables the software – knowing that an image has been shot with a particular camera and 
lens, at a certain aperture and focal length – to calculate that a particular pixel must have its 
value increased by x%, moved by y% in this or that direction, and corrected by z% in, say, the 
red channel. But you won‘t have to do a thing: the software will download the profiles for your 
camera and lens, then silently and effortlessly apply the appropriate corrections.  
  

Our software analyzes your images, one by one 

As every photographer knows, every photo is unique. Even if you have shot the same subject 
with the same equipment, two images will always differ: one has some grain in a dark zone, 
while another lacks contrast and the third suffers from excessive backlighting. Most programs 
deal with this uniqueness by using an elementary solution: they offer a wide range of 
corrections, and leave you to do the work. DxO Optics Pro v6.6 has a radically different 
approach. We analyze the image, we find the corrections to be done, we carry our these 
corrections, and we show you the result, in case you want to fine-tune this or that correction to 
your taste.  
  
Of course, analyzing an image zone by zone and pixel by pixel is a highly complex task.  
Finding that a particular subject is back-lit and needs not only additional light (as if you‘d used a 
fill-in flash) but also heightened local contrast. Seeking out the minute colored fringes round the 
edges of some objects. Detecting highlights that are close to "burning out" and need to be 
preserved. Traditionally, all these tasks would have been accomplished by skilled operators in 
photo laboratories. Now that operator is an extremely powerful application. This auto-analysis of 
any particular image is our second exclusive feature. 
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What DxO Optics Pro does for your images 

  
● If you have shot Raw, DxO Optics Pro processes your photos using the best converter ever 
designed; when transforming the raw sensor data (the "demosaicing" process, among others), 
this converter is virtually free from artifacts;  
  
● DxO Optics Pro automatically corrects all five optical distortions (geometric distortion, 
vignetting, chromatic aberration – both longitudinal and lateral – and lens softness), thanks to 
the high-level measurement database that our labs have been building up for years;  
  
● DxO Optics Pro finely corrects the exposure of your photo, with an automatic adjustment 
(Raw images only) to keep highlights from 'burning out', and even recovery of some partially 
burnt-out highlights.  
  
● Thanks to the measurements made in our labs on each camera body, DxO Optics Pro has the 
best de-noising process available, letting you shoot Raw or JPEG photos at speeds as high as 
 ISO 100,000.  
  
● DxO Optics Pro offers a unique automatic correction of contrast and lighting in shadows, 
equivalent to a fill-in flash, to radically improve any high-contrast or backlit picture.  
  
● DxO Optics Pro offers an unrivaled option to change the color rendering of your photo, as if it 
had been shot by another camera, or on a particular film.  
  
● DxO Optics Pro offers an exclusive correction tool for wide angle shots, which corrects 
deformation of faces and bodies by using non-conventional (cylindrical or spherical) perspective 
methods. 
  
● All the above corrections and features are automatic, while letting you fine-tune their settings 
to adapt them to your taste (apart from the last correction mentioned above, perspective 
correction, which is semi-automatic). 
  
  
Note: Throughout this user guide, we use certain terms which are specific to DxO Optics Pro, 
such as “Preset”, “Project”, “Source image”, etc. All these terms are listed and defined in detail 
in the Concepts and vocabulary chapter of this guide.  
  
About DxO FilmPack 3 plug-in for DxO Optics Pro 
  
DxO FilmPack is an optional plug-in which emulates the appearance of a certain film type on 
digital photos. More than 60 films are available for emulation. This emulation takes place at 
different levels: the color rendering of the image; the general rendering of the image (e.g. 
contrast or saturation); and finally the film grain.  
  
DxO FilmPack 3 exists in two editions: 
–  DxO FilmPack 3 Essential 
–  DxO FilmPack 3 Expert. 
These editions differ in terms of features, which are documented in this user guide. 
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A trial version of DxO FilmPack plug-in for DxO Optics Pro is available within DxO Optics Pro 
and can be launched via the Help menu. This trial can be used for 31 days. During this period, 
the trial can be switched as often as desired from Essential to Expert, and from Expert to 
Essential. 
  
Purchasing one of the DxO FilmPack 3 editions gives you access to three versions of the 
software, which can be installed simultaneously on your computer, allowing you to choose at 
any moment between them: 
– The ―plug-in for DxO Optics Pro version‖ is wholly integrated with DxO Optics Pro (versions 
6.6 and above).  
– The ―standalone version‖ is a separated application, which functions on its own.  
– The ―third party plug-in version‖ works with most well known image editors: Photoshop CS5 
(as well as CS4), Apple Aperture 3, Adobe Lightroom 3. 
  
To buy and activate DxO FilmPack, you should use this link. 
  
To download DxO FilmPack user guide and activation guide, you should use this link. 
  
Note : Since DxO FilmPack – in its plug-in for DxO Optics Pro version – is wholly integrated in 
the usual workspace and commands of DxO Optics Pro, all its features are described in the 
present user guide. Only the standalone and third-party versions have a specific user guide. 

https://shop.dxo.com/login.php
http://www.dxo.com/en/photo/support/Installation_Activation_Upgrade
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What you should know before you begin using DxO Optics Pro 
  

1.- Whether on Raw or JPEG images, DxO Optics Pro is automatic by design 

Because it has tested your equipment and knows its limitations, and because it analyzes your 
images thoroughly, one by one, and pixel by pixel, DxO Optics Pro automatically corrects their 
defects. The "auto" mode is not some kind of simplified mode intended for beginners. It is the 
natural working mode of DxO Optics Pro. More often than not, this mode provides the best 
results attainable. Therefore, you should consider manual corrections not as a substitute, but as 
a complement, designed to fine-tune a correction process that remains fundamentally 
automatic. 
  

2. Processing a batch of images is the rule 

DxO Optics Pro processes an unlimited number of images in one batch. Whether these images 
all use the same correction settings, or have been individually fine-tuned, you need just one 
click to launch the processing for the whole batch. 
  

3.- The software generates multiples outputs in one pass 

Whether your batch contains 3, 30, or 300 photos, the software generates as many outputs for 
each of them as you want: JPEGs or TIFFs, 8- or 16-bits, in this or that directory, with such and 
such a suffix, etc. When you come back, all the corrected images will be there waiting for you, 
named as you want and stored where you want them.  
  

4.- Your original images stay unchanged: non-destructive processing 

All the corrections are applied not to your originals but to a duplicate of them. Your originals stay 
in their original folder, in their original condition, with their original name. DxO Optics Pro is a 
100% secure process, in which information and quality are added, but never lost. 
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Some guidelines when using DxO Optics Pro 
  

1.- Lose as little information as you can 

Each time a photo undergoes some post-processing, some information is lost, which will not be 
recovered. Since DxO Optics Pro is currently the most powerful post-processing software 
available, you should use it for all this processing, and avoid using any other upstream software, 
including the in-camera programs. 
For JPEG photos, this means you should keep all in-camera treatments to a minimum: anti-
noise, sharpening, etc.  
The most effective solution will always be to shoot Raw. This choice will you allow you to make 
the most of all the technical qualities of your camera and lenses. It will also allow your pictures 
access to the whole repertoire of DxO Optics Pro corrections, since some of these can't be 
applied to JPEGs.  
  

2.- Zoom in 

This advice is repeated many times on your screen and in this guide. But experience has shown 
that many users forget this and stay at a small display scale when applying corrections. So we 
need to emphasize: none of the corrections in the "Detail" palette will be displayed in preview at 
zoom factors below 75%, even if this means you can only look a quite a small part of your 
image at a time — but you can always move this section around to examine specific parts of the 
image. 
  

3.- Use presets 

When adding an image to your Project, this image has a correction preset automatically 
associated to it (by default the ―DxO Default v2‖ preset). You may want to try other presets that 
will give a different look to your image. This is a good way to explore the capabilities of DxO 
Optics Pro without moving a single slider. 
Once you have found your way around and feel comfortable with DxO Optics Pro, you can fine 
tune the settings to your taste,  and save them as your own preset to re-use later, or even set it 
as your default preset when adding images to your Project.  
  

4.- Raw White Balance first 

The large number of corrections available in DxO Optics Pro can make things appear complex. 
A simple guideline, if you want to depart slightly from Auto mode, would be this:   
- begin with the Raw White Balance: set it by pointing the White balance picker on a zone which 
you know is grey, and fine-tune your choice with the color temperature slider, for a slightly 
cooler / warmer mood; 
- if your photo has burnt-out highlights or strong reflections, try one of the automatic highlight 
recovery modes, in the Exposure compensation sub-palette; 
- try the various color renderings proposed in the color rendering sub-palette; 
- choose your level of contrast by trying the various automatic modes proposed in the Lighting 
palette; 
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- if necessary (for example if the horizon line is sloping, or if the photo was taken looking 
upwards), correct perspective distortion using one of the tools (horizon, parallels, rectangle) 
available in the Keystoning sub-palette. 
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Five minutes to process your first five photos 
  

1. Choose five images 

Open the software. In the small pop-up window, click "start using DxO Optics Pro". In the upper 
left pane, browse your computer and disks to find five photos that you know well and like. Drag 
and drop them to the lower pane (the "PROJECT" pane).  
Note: each photo has been automatically associated with a ―Preset‖ that drives the automatic 
corrections. You will learn later how to change these presets. 
  

2. Load the DxO Optics Modules 

When you drop your thumbnails in the "PROJECT" pane, the software will ask you to download 
the DxO Optics Modules needed to automatically perform optics corrections. These modules 
relate to the specific camera and lens combination that was used to shoot the photos. Just click 
in the dialog window; the modules will download and install automatically. 
  

3. Open the "Process" tab and launch the processing 

In the upper bar of your DxO Optics Pro window, click the "Process" tab. Now the upper part of 
your screen changes, while the lower part (containing your five photos) stays the same. In the 
upper bar, click the blue "Start processing" button. If a window opens asking you whether you 
want to process all or only a selection of your photos, check "All images in the project" and click 
OK. The processing stage lasts something like one minute per Raw picture.  
  

4. View the processed images 

In the upper bar of your DxO Optics Pro window, click the "View" tab. A new screen appears, 
with the same lower part containing your images and an empty upper pane. Click on one of the 
thumbnails. Your corrected photo will display in the upper pane. Zoom in by using one the tools 
in the upper Command bar (zoom tool, magnifying slider). To compare the corrected image with 
the original image, either click on the large image, or choose a side-by-side display (icon in the 
upper Command bar). To display another one of your photos, click on its thumbnail in the lower 
pane. [Unless you have changed this setting, your Output Images have been saved in the same 
folder as the Source Images, with a ―_DxO‖ suffix added to the image filename.]  
  

5. Just five minutes have elapsed  

You have automatically processed five of your favorite photos using DxO Optics Pro. We hope 
you are convinced just how powerful it is. 
  

6. (optional) Begin fine-tuning corrections 
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In the upper bar of your DxO Optics Pro window, click the "Customize" tab. A new screen will be 
displayed, with your thumbnails in the lower part, and an empty screen in the middle of the 
upper part. Click on a thumbnail. It will display in the upper pane. On the right of your screen, 
you will find eight correction "sub-palettes" (one sub-palette for each correction). Use them 
freely, to see their effect on the image. To compare with the original image, either click on the 
displayed image, or select a side-by-side display (click the icon in the upper Command bar). To 
go back to the Auto settings, click Auto in each sub-palette. To totally disable a correction, 
uncheck its sub-palette. When you are satisfied with your new settings, process your picture 
again. 
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Step 1- the Select tab 

About the Select tab  
  

  
The Select tab is composed of three panes : one (top-left) to navigate through folders; one (top-right) to 
display the folders' content; one (bottom) to show which images have been inserted into your DxO Project  

   
When you open DxO Optics Pro, you see the first of four tabs. This one is named ―Select‖, and 
corresponds to the first of the four steps needed to process your photos. Its purpose is to put 
together a batch of images (a ―Project‖) that are going to be processed together. Each image 
will be accompanied by a ―Preset‖, which is a simply a list of the corrections to be applied to this 
image. 
   
Note: At this stage you do not have to worry about presets, since DxO Optics Pro has a default 
preset which takes care of all the corrections and is applied automatically to all incoming 
images. But of course you can also choose another preset to accompany your incoming photo.  
   

How to use the three panes on your screen  

- The left-hand ―Browse‖ pane is used to navigate through folders, to locate the photos you want 
to process.  
- The right-hand pane shows the content of the folder selected in the left-hand pane. Those two 
panes work in conjunction with one another: one shows where a photo is located, the other 
shows which photo it is.  
- The Project pane, at the bottom of the screen,  is where you will place the images you want to 
process.  
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These three panes can be adjusted to suit your needs. They are delimited by two ―separator 
bars‖, one horizontal and one vertical, both indicated by three central dots. Each bar can be 
moved around at will, changing the relative sizes of the three panes.  
   
Tip: If you can‟t see all three panes, check that the vertical and horizontal separators have not 
been moved to the very top or bottom or side of the screen.  
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Left-hand pane – Browsing your libraries 
  

 
Using the computer‟s file system: one of the three ways to browse for your photos 

  

Where can you browse ?  

A DxO Project can gather photos from various origins. They may differ not only in terms of 
shooting date, camera used, lens, speed, aperture, etc. — they may also originate from very 
different storage environments. Some may simply be found via the normal computer‘s file 
system — whether they‘re stored on a hard disk, a CD-ROM, DVD, photo-card, or other 
medium. Others may originate from a previous DxO Project. And finally, some photos may be 
retrieved from a Lightroom catalog. To switch between these three situations, click on the 

relevant one of the three icons on the top bar of the left-hand pane  
  

Browsing the computer’s file system (default) 

By default, the ―Browse‖ pane is configured to navigate through the directories on your 
computer and its peripherals (additional disk, CD-ROM, DVD, memory card, etc).  
Simply navigate to the directory where you have saved the images you want to add to your 
Project. Once you can see the directory icon, click on it to display its contents in the right-hand 
pane. 
  

Browsing previous DxO Projects 

Select the ―Project database‖ icon (the middle one) from the three icons at the top of the 
―Browse‖ pane. The pane will show a chronological list of the Projects you have already 
processed (if you are using DxO Optics Pro for the first time, this will be empty). Clicking on one 
of your previous Projects will display the thumbnails of its images in the right-hand pane. 
Double-clicking will upload the entire previous Project into the present Project.  
Saved Projects can also be accessed from the ―File‖ menu > ―Open Project‖.  
  
Note: if you move your source images after you have run a Project, DxO Optics Pro may not be 
able to find them.  
  

Browsing Lightroom catalogs 
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To browse Lightroom catalogs that you have stored on a disk, click on the ―Adobe Lightroom 
catalogs‖ icon at the top of the ―Browse‖ pane. The pane will show the list of your Lightroom 
catalogs.  
  
Note:  
- If some images have been converted from RAW to JPEG in Lightroom, DxO Optics Pro will not 
be able to apply optical corrections to them in auto mode. 
- In the event that Lightroom is already running, the catalog you are trying to access may be 
locked. You‟ll have to quit Lightroom in order to unlock the catalog and allow DxO Optics Pro to 
access it. 
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Right-hand pane: selecting your photos 
  
Selecting photos is simple: when you have opened a folder in the left-hand pane (the navigation 
pane), the right-hand pane displays its contents. You then pick the images you want and put 
them into the bottom pane. Picking an image is easy: click on it (which will highlight it), then 
either drag it to the bottom pane, or click the ―Add to Project‖ icon. If you want to select several 
images at the same time, click on the first one; then (for consecutive images) press ―Shift‖ and 
click on the last image;  or to add non consecutive images, press ―Control‖ and click each 
additional image separately. 
  
Note: When you add an image to a Project, you do not physically move or copy your original 
image. The original image remains unchanged and uncopied, in its original directory. For DxO 
Optics Pro,  adding an image just means that it creates a shortcut (a link) to where the original 
image is located on your computer and adds this shortcut to your Project. 
  

How to look closely at your photos 

  
To display the images as a list, click on the first of these two icons  . To display them as 

thumbnails, click on the second of them. Then, select their size with the slider  . 
  
To benefit from a still larger display, you could open a "preview window". For this, select either a 
single image or multiple images, then use the menu command View > Display in preview 
window, or use the contextual menu (right-click on the image or the multiple selection); or simply 
use the shortcut "Spacebar". 
  
The image is then displayed in an independent window that can be resized. Left and right 
arrows can be used to display either the thumbnails in the underlying pane, or the images 
belonging to the multiple selection.  
  
This window has the same zooming tools as the main window (see below). It has the same "Add 
to Project" button as the main window. It closes as an ordinary window.  
  

Every selected photo needs a “Preset” of corrections 

  
A basic principle of DxO Optics Pro is that, from the moment it enters the ―PROJECT‖ pane, a 
photo must be accompanied by a ―Full preset‖. A ―Full preset‖ is a list of all possible corrections, 
where the status of each correction is mentioned as either  disabled or enabled — in the latter 
case, enabled with a certain parameter. For example, ―Exposure correction‖ can be either 
disabled or enabled ; if it is enabled, a degree of correction must be specified, e.g. ―−2‖, 
meaning ―−2 stops‖. 
  
Even if you are just starting out with DxO Optics Pro, it‘s very important for you to understand 
what a ―Preset‖ is, for in all cases, even when you‘re using the application in full automatic 
mode, it is this Preset (in this case, the default Preset) that allows you not to bother about 
adjusting the corrections yourself. 
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Choosing a preset or using the default one? 

  

 
When you insert an image into the Project pane, you may use the default preset, or choose another one 
in a list 
  

To the right of the ―Add to Project‖ button is a drop-down menu with a choice of presets, in 
which ―DxO default v2‖ is selected by default. If you press the button without clicking on the 
menu, this preset will accompany your image and govern all its corrections, unless of course 
you make manual changes to one or more corrections at a later stage. 
  
The ―DxO default v2‖ preset may be regarded as a set of moderate corrections, employing a 
good part of DxO Optics power (but not all of it) to produce images of very high optical quality 
with good saturation and excellent correction of shortcomings in lighting.  
If you want to use one of the other ready-to-use presets, click in the list.  
  
It is equally possible to build your own presets and save them, so they will appear in the drop-
down menu and be available to accompany any new image. 
  
Note: when you shut down the software, the last preset selected (from the drop-down menu 
on the Command bar of the Select tab) will be saved and used as the default preset the next 
time you open DxO Optics Pro and add images.  
  
  

Select tab Command bar 

 
  
This Command bar contains tools to make editing easier, and for adding the selected image to 
the ―PROJECT‖ pane using a chosen preset. From left to right: 
  
● The ―Selected image counter‖displays info about the selected images. For example, 

  means that 5 images are selected in a directory of 12 images, of which 1 is not 
shown (filtered). 
● Two icons   let you switch between thumbnail view and list with details view.  

● Clicking on the next icon  will open a menu for sorting the displayed images. This menu 
lists the sorting criteria, and the active one is marked with a triangle.  

● Clicking on the next icon  opens a menu for filtering the displayed images. 

● A slider   changes the size of the displayed thumbnails. 
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● The last tool on the right is the Presets menu: see above for a brief explanation, and here for 
a detailed explanation. 
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The Project pane 

Using  your “PROJECT” pane 

  

 
Undocked from its usual position at the bottom of the screen, the “PROJECT” pane, like an independent 
window, floats and can be resized at will 

  

What this pane is used for 

The ―PROJECT‖ pane is initially located at the bottom of your screen. It shows thumbnails of all 
the images belonging to your Project. You will be using this pane at every step in the DxO 
Optics Pro process: ―Select‖ (when you will first populate this pane with your images), 
―Customize‖, ―Process‖ and ―View‖. Note that you can remove images from your Project at any 
stage. But to add images, you will have to temporarily go back to the ―Select‖ step, then return 
to the stage your were at. 
  

How to resize and undock the pane 

The ―PROJECT‖ pane can be displayed in two manners: either as part of the overall DxO Optics 
Pro window, or as an independent window. In the first case (the default), the pane forms the 
lower part of the DxO Optics Pro window.  It can be resized by dragging the ―separator‖ 
between it and the upper panes. To undock the ―PROJECT‖ pane, i.e. make it independent 
(second case),  you will need to drag the ―command bar‖ (located at the top of the pane, just 
under the separator) anywhere on the screen, or right-click in this icon bar and click ―Undock 
Project window‖, or else use the Menu command ―View > Undock the PROJECT window‖.  
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“PROJECT” pane: the command bar 

  
The command bar sits at the top of the ―PROJECT‖ pane. From left to right, it contains four 
commands relating to the Project itself, and eight commands relating to the individual images.  
  

Commands relating to the Project 

● the ―Project information‖ button shows the Project properties in a separate window; 
  

● the ―Back to select‖ button allows you to go back temporarily to the first step in the process, 
to add further photos to your Project; 
  

● the ―Sort images‖ button  opens a sub-menu with more than 10 sorting criteria to choose 
from; 
  

● the ―Filter images‖ button  opens a sub-menu with 7 filtering criteria to choose from; 
  
  

Commands relating to the images 

  
● the ―Selected image counter‖ displays info about the selected images. For example, 

   means that 1 image is selected, in a directory of 11 images. 
  

● the image information button displays the properties of the selected image, in a pop-up 
window; 
  

● the two rotation arrows help you display the image with the correct orientation; 
  

● the ―Virtual copy‖ button  makes a duplicate copy of the source image, to which you can 
apply corrections that are different from the ones used for the first image you selected (more 
about virtual copies). 
  

● the ―Recycle bin‖ button removes the selected image from the Project (this does not delete 
the original file); 
  

● the processing button starts the image processing stage; 
  

● a slider lets you change the size of the thumbnails displayed in the Project 
pane; 
  

● the buttons are only visible under the ―Customize‖ and ―View‖ tabs where 
there is a multiple selection. They let you browse within the multiple selection without 
deselecting it.  
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● a button for sending images to Flickr photo galleries (only available under the ―View‖ tab); 
  
● a button for sending images to Adobe Lightroom software, if this is installed on your 
computer (only available under the View tab); 
  
● a button that takes you on to the next step. 
  
  

Sorting images 

  
"Sorting images" works in exactly the same way in the right-hand pane and in the Project pane. 
Sorting consists of ordering your images based on criteria selected from a dialog box that you 
access from the Sort button. 
  
  
The options available for the Sort button are as follows: 
  
● "Insertion order": the order in which you added the photos to the Project; 
  
● "RAW format images"; 
  
● "Name" – by file name in alphanumeric order; 
  
● "Extension" – used to separate different types of Raw, JPEG and TIFF images; 
  
● "Size" – by file size; 
  
● "Date" – by file modification date; a useful option for doing a quick search of the most recent 
files in a folder; 
  
● "Dimensions" – by image width; 
  
● Camera – by type of device; 
  
● Lens – by type of lens; 
  
● Ranking – by star rating (only visible if this option has been enabled in the menu ―Edit > 
Preferences‖). 
  
● "Processing status": this can have following values: "error", "done", "processing", "awaiting 
processing" (only visible if this option has been enabled in the menu ―Edit > Preferences‖). 
  
  

Filtering images 
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Filtering images works in exactly the same way in the right-hand pane and in the Project pane. 
Filtering affects which thumbnails are displayed in the Project pane: if you uncheck an item on 
the list, images with these characteristics will be invisible. 
  
Note: Images that are not displayed cannot be selected for the Customize or Process steps. 
  

  
The options available for the Filter button are as follows: 
  
● Show Raw images – when this option is checked, Raw image files are displayed in the 
―PROJECT‖ pane. If it is unchecked, they are not. 
● Show RGB images – when this option is checked, RGB image files (usually JPEG or TIFF) 
are displayed in the ―PROJECT‖ pane. If it is unchecked, they are not. 
● Show unprocessable images 
● Show images waiting for processing 
● Show processed images 
● Show images in processing error 
● Show images being processed 
● Show images with traffic light green (yellow / red) 
● Show images with ranking of (0 to 5) stars 
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Within the “PROJECT” pane: the thumbnail icons 

  

About thumbnail icons 

  
The thumbnails shown in the ―PROJECT‖ pane can include a large number of icons, designed 
to inform you about the specifics of these thumbnails. Since in many cases you will not need all 
the information available, you have the choice to enable or disable the icons, or show them only 
on mouseover. DxO Optics Pro has chosen one of these three possibilities as the default for 
each icon. If you want to change this status, and show fewer, more, or different icons, use the 
Menu choice ―Edit‖ > ―Preferences‖ > ―Display‖ tab. In the lower part of the screen (titled ―Project 
section‖), you will choose a status for each icon. To help you in this choice, we give details here 
about each icon, its meaning, and its different values. 
  

 
A thumbnail in the Project pane with many icons enabled; clockwise from top left: the recycle bin; the 
Processing status and Module status icons; the yellow light “not yet made up my mind for processing or 
not”; the “rotate right” icon; the filename; the “virtual copy” and  “rotate left” icons; and the stars used to 
rank the image (here: zero star). 

  

Processing status icon 

  
(this icon is shown by default) 
–  means that the thumbnail is waiting for processing; 
  
–  means that the thumbnail has already been processed; 
  

–  means that a processing error has occurred;  
  

–  means that the thumbnail must not be processed;  
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–  means that the thumbnail cannot be processed. This may be due to the fact that the image 
is too small (very small images cannot be processed by DxO Optics Pro), or that it has already 
been corrected (the software cannot process an already-processed image).  
  

Filename 

  
The filename is shown by default. It appears in the usual form ―somename.extension‖, where 
somename is the name of the image (given by you, or automatically assigned by the camera, 
for example); and extension is either a standard image extension (jpeg, raw, tiff, etc.) or a 
proprietary extension (like CR2, for Canon raw images). When you have used the ―Virtual copy‖ 
command to create sub-versions of a given image, the filename may be followed by a suffix, 
e.g. ―img7.cr2 (light)‖, ―img7.cr2 (lighter)‖, ―img7.cr2 (+contrast)‖. This suffix is not part of the 
official Windows name, and appears in brackets (). (More about virtual copies) 
  

Module status icon: 

  
(this icon is shown by default) 

–  means that the DxO module for this thumbnail is ready to operate;  
  

–  means that the DxO module for this thumbnail is not available; 
  

–  means that the DxO module for this thumbnail is not ready but is available for download; 
  

–  means there is ―optical module ambiguity‖; usually, this means that the software does not 
know, from the EXIF data, how to choose between two lenses with very close characteristics 
(e.g. two 12-24 mm f/4 zooms from two different makers); in this case, you‘ll need to click on the 
icon, displaying a dialog box that will allow you to resolve the ambiguity.  
  
  

Rotate thumbnail icons: 

The  and  icons will, by default, appear only when you hover over the thumbnail. They let 
you rotate the image. 
  

Recycle bin icon:  

This  icon removes an image from the Project. By default, it appears only when you hover 
over the thumbnail. Since DxO Optics Pro does not manipulate the images themselves, it does 
not affect the real file stored on the disk, but only shortcuts to images.  
  

Virtual copy icon:  
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By default, this  icon appears only when you hover over the thumbnail. It indicates that this 
image is a Virtual copy. Let‘s remember that a Virtual copy is a copy of an image that will be 
used for testing different processing settings. For example, from a given image titled ―forest.cr2‖, 
you might have decided to make three variants : ―forest.cr2 (basic)‖, ―forest.cr2 (+contrast)‖ and 
―forest.cr2 (++contrast)‖ to test three ways of progressively enhancing the contrast. In such a 
case, all three images will show the Virtual copy icon. (More about virtual copies)  
  

Stack icon  

By default, this icon  appears only when you hover over the thumbnail. It indicates that this 
image is in fact a ―stack‖ of images. This means that ―under‖ the image there are other images 
that you have chosen to stack, so that all the stacked images will be processed with the same 
settings and appear as only one thumbnail (the ―master image‖), reducing clutter on your 
screen. (see the next section: ―Grouping your images into stacks‖ for details) 
  

Missing data icon 

This icon  is hidden by default. It shows that the focal length and/or focusing distance have 
not been properly written by the camera into the image EXIF data. This lack of information may 
slightly affect the precision of the automatic distortion correction. In this case, one or two sub-
palettes (depending on whether one or two items of data are missing) will display in the 
Geometry palette, under the ―Customize‖ tab. By default, as you will see in these sub-palettes, 
DxO Optics Pro sets the focusing distance to infinity, and the focal length to the value written in 
the EXIF data. If you have more precise information about the shooting data, you should enter 
it. (more about these sub-palettes) 
  

Ranking icon 

This icon  is hidden by default. It is used to score your images, from 0 to five stars; 
they can then be sorted on the basis of their ranking. 
  

Traffic light icon 

This icon  is hidden  by default. It is used to show which images are to be processed (green 
light), must not be processed (red light) or are pending your decision regarding processing 
(yellow light) — this is the default value when an image is added to a Project. When processing 
begins, images with green and yellow lights will be processed, whereas images with red lights 
will not be processed.  
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Building and using stacks 

  

About stacks  

  
A ―stack‖ of images is used to organize your images into groups. This makes it possible not only 
to reduce clutter in the ―PROJECT‖ pane, but also to apply settings to a whole group of images. 
In this sense, a stack is equivalent to a permanent multiple selection. 
  
You should consider building a stack whenever some of your images need the same processing 
parameters. A usual case is a series of images shot under the same lighting conditions. 
  
A stack always has a ―master image‖ — the one that appears on top. This is the image shown 
on the ―Customize‖ tab when you select a collapsed stack. If image stacking is enabled in 

"Preferences‖ and you have grouped your images into stacks, the corresponding icon   will 
appear on the first image in each stack. 
  

 
Of the two thumbnails in this PROJECT pane, one is a regular one; the other is the “master image” of a 
stack; it is showing the stack icon, just under the bin icon.  
  

Creating and managing stacks 

By default, stack building is disabled. So your first move will be to enable this function, in the 
following menu: 
Edit > Preferences > ―Display‖ tab > Bottom section: ―Enable image stacking‖ option. 
  
Then you can build your first stack by making a multiple selection. When all the desired images 
are selected (i.e. highlighted), build them into a stack by right clicking on one of them, and 
choosing Stack > Stack images (you can also use the menu: Project > Stack > Stack images). 
All the images belonging to the stack will disappear except the ―master image‖, which will now 

display the stack icon: . 
  
If you want to add new photos to a stack, select the photos(s) to add, then right-click on one of 
them, go to the sub-menu: Stack > ―Add items to stack‖; a dialog box will open, showing the 
stacks already set up; you‘ll need to click on the one to which you want to add your images. The 
reverse process can also be used. Finally, a stack can be completely dismantled using Stack > 
Unstack images.  
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To check which photos are in the stack,  click on the stack icon, or use Stack > Expand stack, 
which will display all the images side by side. The reverse command is Stack > Collapse, or 
more simply a click on the stack icon. Another very effective way to check the contents of a 
stack and / or change its master image is to hover your mouse over it, then use your mouse 
wheel to scroll through the thumbnails; when you move the mouse off the image, the thumbnail 
you left it on becomes the new master image. 
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Step 2- the Customize tab 

About the Customize tab 
  
  
In DxO Optics Pro‘s four-part structure (1. Select, 2. Customize, 3. Process, 4. View), this 
Customize tab is the second, and also the most complex. In view of this complexity, perhaps we 
should start off by reminding you right away of a number of ‗safety nets‘: 
  
● Using the Customize tab is optional. You can proceed directly from step 1 (the Select tab) to 
step 3 (the Process tab). The only effect will be to apply automatic settings to your photos: those 
of the preset that was selected and was automatically associated to your images when they 
were added to the Project. In most of cases, you will be very satisfied with the effect of the "DxO 
default v2" preset. 
  
● To make learning easier for you, we have prepared three working environments 
(‗workspaces‘) of increasing complexity. The easiest and simplest is the software‘s default 
workspace: "DxO First Steps workspace". Until you feel confident enough to use the more 
complex workspaces, we recommend you keep this one active. 
  
● Whatever corrections you apply to your photos, the originals always remain unchanged. Each 
processed photo is a fresh copy of the original, and does not delete it. At worst, you might waste 
a little time, but you will never lose your original images! 
  
● For most settings, you can go back to the automatic setting, either by pressing the Auto button 

, or by applying the ―DxO default v2‖ preset to your image, thus resetting all settings to 
their automatic mode. 
  

Exploring the Customize tab 

  
The screen you see when you enter the Customize tab for the first time is quite complex, and 
we believe it‘s really important for you to start by finding your way around this workspace. Once 
you know how to maneuver palettes or sub-palettes and use the main tools from your command 
bar, you‘ll feel more confident. So we advise you to read the first section of this chapter carefully 
and actually try out all the elements present on the screen. 
  
In the same way, we advise you to master the Move / zoom palette, as this basic tool will allow 
you to explore your image at high degrees of magnification. 
  
You can explore the rest of the Customize tab, especially the corrections themselves, gradually, 
with or without a structured progression. 
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Managing your Workspace 

About your workspace 

  

 
The two panes of the Customize tab. One (below), the Project pane, contains the thumbnails of the 
images to process. The other (above), the Image pane, contains one photo at a time, chosen among the 
photos below. The Customize pane will allow to fine tune the corrections of this particular photo. In the left 
column, we can see visualization tools. In the right column are several palettes, each one ruling a 
particular correction. The central column displays a simulated view of the corrected image.  
  

Two panes on your screen 

The Customize tab is divided into two panes. One, at the bottom, is the Project pane, into which 
you loaded your pictures in the first step of your work. The other, at the top of your screen, is the 
Image pane. The purpose of the Image pane is to display the photos from the Project pane one 
at a time, to show their detailed characteristics and allow you to fine-tune the corrections 
required. 
  
Remember: even though it does open up interesting possibilities for fine-tuning, the Customize 
tab is entirely optional. You can always go directly on from the Select tab to the Process tab, in 
which case all the corrections will based on the preset associated with your images 
automatically as they were added to the Project.  
  

What is each pane used for? 

The interaction between these two panes works as follows: when you open the Customize tab, 
an image from the Project pane is automatically displayed: either the selected image (if one is 
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selected), or the first of the row (if none is selected). You will work on this image until you are 
satisfied with the corrections it needs. Then you will click on another image, which will display in 
the Image pane, etc. 
  
Note: at any moment the Image pane and Project pane can be resized by dragging the 
separator bar between them (marked with three dots). 
  

The different parts of the Image pane 

The Image pane comprises four different parts: 
  
- At the top of the pane is the command bar: 

 
  
This bar is mainly about displaying your images the way you want. See here to read more about 
this bar and its tools.  
  
- At the bottom left are a number of "palettes", like Tools or Move/zoom. The latter is used to 
examine and analyze your image, while the Tools palette provides shortcuts to tools contained 
in the corrections palettes. See here to read more on palettes and here for more about image 
analyzing palettes. 
  
- At the bottom right appear other palettes, like "Exposure compensation", "Vignetting" or 
"Distortion". These are the corrections palettes. 
  
- In the bottom center is the image you are currently working on. The two stages of this image 
(corrected image / reference image) are displayed either side by side or alternately. See here to 
read more about the way you can display this image.  
  
  

Workspace basics 

  
Some parts of the default workspace cannot be changed. These are the upper command bar, 
and the center sub-pane displaying the image.  
  
What can be changed and adapted to your needs is the way palettes are displayed. Not only 
can you choose which palettes will or will not displayed according to your needs, you can also 
decide in which part of the screen, left or right, they will display. This allows you to use 
personalized workspaces, which will only display this or that correction and exclude others that 
you do not need. The default workspace in DxO Optics Pro is DxO First Steps, but other more 
complex ready-to-use workspaces are available, as well as customized workspaces. (more 
about workspaces) 
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Command bar 

  

 
Left–right: the three display icons, two icons for information and grid, the three pointers (standard, hand, 
magnifying glass), four zoom commands, and the presets drop-down menu 

  
The command bar is at the top of the Image pane. It is a fixed component of your workspace: 
whichever workspace you choose, it will remain integral part of it. From left to right, it contains 
the following groups of icons: 
  

● The three display icons . The "Single image display" icon (left) displays a preview of 
the image as it will be corrected; a click on this image (or the combination Ctrl + D) lets you 
toggle the display between the corrected image and the Reference image. The "Dual image 
display" (center) displays the corrected image and the Reference image side by side. The drop-
down menu (on the right) lets you decide which image will be the Reference image. Most of the 
time, it will be the Source image. But if you have created Virtual copies of an image, you can 
use one of these copies as a Reference image, provided that this Virtual copy has already been 
processed. In this case, the processed Virtual copy(ies) will display in the drop-down menu, 
alongside with the Reference image. Comparing to a Virtual copy allows you to compare one 
set of corrections versus another, instead of one set of corrections versus the original. 
  

● The Information icon  shows or hides two semi-transparent captions: ―before correction‖ / 
―correction preview‖ tells you which image is being displayed; "Zoom factors below 75%..." is a 
reminder that some corrections cannot be appreciated and adjusted without a high degree of 
magnification. The Grid icon   shows or hides a grid overlay over the image; this is particularly 
useful for correcting distortion and keystoning. 
  

● The ordinary Pointer tool , when active, and when the ―Single image display‖ mode is 
enabled, is used to toggle between the corrected image and the reference image, simply by 
clicking on the reference image or releasing the mouse button (Ctrl + D provides the same 

effect). The Hand tool  can be used to move the visible area of the image. When you click 

with it on the image, the Magnifying glass lets you magnify it by a factor of up to 1600%.  
  

● The zoom commands let you adjust the scale of the 
display between 2% and 1600%. The first two sub-icons are used: (1) to select a fit-to-screen 
display; and (2) to select a 100% (or 1:1 scale) display (= actual size). The drop-down menu is 
used to quickly reach some commonly-used display scales (six choices, from 25 to 400%) or 
enter the scale factor you want. Lastly, the slider (display scales from 2% to 1600%) lets you 
zoom in or out quickly.  
  
Tip: if your mouse has a scroll wheel, using this is the fastest way to zoom in and out on the 
image. 
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Managing palettes and workspaces 

  

Using and moving palettes 

Palettes are sets of commands that have a common purpose: e.g. all the commands relating to 
color correction in the Color correction palette. Sometimes these commands are grouped into 
sub-palettes; for example, the Color correction palette has a Raw white balance sub-palette, a 
Vibrancy sub-palette, etc.  
  
Palette title bars are light grey, with the name of the palette in white. Clicking on the palette bar 
expands / collapses the content of the palette. If the palette contains sub-palettes, these are 
expanded / collapsed by clicking on the triangle in their title bar.  
  
Palettes are docked by default on the right (correction palettes) and left (image analysis palette) 
of the image pane. But they can be moved freely anywhere on the screen; to move a palette, 
drag its bar to the desired place. To close (hide) it, click on the cross at the right of the bar. You 
can also move a palette by using the drop-down menu on the palette bar. This menu lets you (1) 
collapse / expand the palette; (2) dock it on the right or left; (3) float it freely on the screen; (4) 
close (hide) it. 
  
All palettes can be docked on one side of the screen: this leaves room for a larger image in the 
center, but tends to clutter the stack of palettes. To leave even more space for the image, you 
can use, in the Palette menu , the Hide / Show palettes command (shortcut: F9), which hides / 
shows all selected palettes.  
  

Using ready-made workspaces 

  

  
The simplest of the three ready-made workspaces: the DxO First Steps workspace 
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The first time you open DxO Optics Pro, only a subset of all available palettes and sub-palettes 
will be displayed on the screen. For example, neither the Histogram palette, nor the Tone curve 
palette, which both need a certain degree of experience, will be displayed. On the contrary, the 
DxO Lighting correction, which radically improves the contrast of any image, or the Distortion 
correction, which cures a very visible defect in digital photos, will both be visible.  
  
This coherent set of displayed palettes, sub-palettes and tools is a "workspace". Three of these 
workspaces have been stored and are provided ready-made by DxO Labs: the First Steps 
workspace (the one you use as a first-time user), the Essentials workspace, and the Advanced 
user workspace. All three of these are accessible via the drop-down menu at the far right of the 
top bar in the main window. They can be characterized as follows: 
  
● The "First steps" workspace includes all the basic tools and correction palettes or sub-palettes 
that will allow you to discover just how powerful the DxO software is. "Lens softness", "Noise", 
and "DxO Lighting‖, for example, are powerful tools that you have to see in action on your own 
images to judge just how effective they are. Do remember, though, that the effect of some of 
these corrections ("Noise", "Lens softness") is only visible at zoom factors over 75%.  
  
● The "Essentials" workspace introduces you to the "DxO Optics Pro world". All the corrections 
are now grouped into palettes and sub-palettes. The very useful "Histogram" palette, and its 
tools to evaluate the clipped zones of the Histogram, is present. And even complex settings, 
such as the "Vibrancy" correction, or the possibility to shift from one color space to another (as if 
you were shooting with another camera or film) are now available. 
  
● The "Advanced user" workspace gives you access to the whole power of all our algorithms 
and research. Dozens of corrections and tools are now at your disposal. The rest is up to your 
own creativity and experience as a photographer.  
  
Note: From the "Essentials" workspace and up, you can use our optional DxO FilmPack 
module, which lets you simulate the color-rendering of many famous films, both color and black-
and-white. 
  
  

Creating a customized palette (advanced) 

  

 
A customized palette allows to group certain corrections (sub-palettes) that you frequently use, even if 
they belong by default to distinct palettes 
  

As you become familiar with DxO Optics Pro, you will notice that you use some correction 
palettes more than others, and even some sub-palettes more than others. This may well be the 
moment for you to create  a palette of your own. You can use the ―Create user palette‖ 
command from the "Palettes" drop-down menu and give a name to your palette. This palette — 
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let‘s say "Peter's palette" — will now display in the palette dock, along with the other palettes. At 
this stage it will be empty. To fill it, all you need do is drag any sub-palette you want into "Peter's 
palette", where it will be duplicated. When you are finished, you can close all the other standard 
palettes, and keep open only Peter's palette, containing all your chosen corrections. 
  
If you want to include your custom palette into a workspace, you‘ll need to create your own 
workspace (see below for saving custom workspaces). 
  
  

Creating a custom workspace (advanced)  

  

 
Saving a personal workspace allows to save the customized palette(s) that you have designed 
  

DxO Optics Pro offers you the possibility of storing your favorite working environment (or 
environments), by saving it (them) as workspace(s).  
To save a workspace, you will 
- decide which palettes you need, and display them; which you do not need, and hide them; 
- have the option to create customized palette(s), if you want to refine your choice to the sub-
palette level;  
- save the workspace as it stands with the command "Save workspace" in the workspace drop-
down menu (last menu at the top right of the main window); you can give this workspace any 
name you like, for example, a name that will remind you of what it‘s for: "Raw landscapes" or 
"neutral color pack shots", etc. 
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Image analysis palettes 

"Move/Zoom" palette 

  

 
Left–right: "fit-to-screen" icon; 100% display icon; drop-down menu with often-used zoom factors; slider to 
use the complete zoom in/out scale. 
  

   
The Move/Zoom palette duplicates the zoom commands displayed in the "command bar", with 
one extra command: 
– Move, with which you can pan the larger preview image in the center of the screen by moving 
a green-bordered box around in the thumbnail.  
  
The rest of the commands are identical: 
  
– The "fit-to-screen" icon lets you expand the image to fill all the available screen area; 
  
– The "1:1" icon displays the image at a scale of 1-to-1, or 100%; remember that this scale is 
essential for being able to see many of the DxO corrections; 
  
– The drop-down menu is used to go quickly to commonly-used display scales (five choices, 
from 25 to 400%) or to enter the scale factor you want; 
  
– The slider (display scales from 2% to 1600%) lets you zoom in or out quickly.  
  
Tip: if your mouse has a scroll wheel, using this is the fastest way to zoom in and out on the 
image. 
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Histogram palette 

  
  

 
The histogram shows, color by color, how many pixels there are for each level of luminance. It shows, 
too, the exact brightness of the zone under the pointer (here : red 181 on a scale of 255; green 190, Blue 
193). And two buttons (bottom left) allow to see, in false colors, the clipped zones (if any) on the main 
image. 

  

About the Histogram 

A histogram is a chart that shows how many pixels there are for each level of luminance. The 
taller each vertical line is, the more pixels the image has of that value. When the peaks are 
mostly located on the left side, we have a shadowy, "low-key" image. When they are mostly on 
the right-hand side, we have a bright, "high-key" image. When the vertical lines cover a good 
spread of the luminance levels, the photo is regarded as balanced. 
  
The DxO histogram tool calculates the brightness values for each color channel, and displays 
them all superimposed on the the same chart. 
  
Note: when you hover on an image, the histogram displays information about the zone under 
your pointer. The color there is copied and enlarged in a patch, and its color channel values 
(e.g. R:118, G:45, B:210, for red, green and blue, on a scale from 0 to 255) are displayed under 
the histogram chart. 
  

How to detect clipping 

When a luminance level goes below the black point, or above the white point, it will be 
constrained to pure black or pure white. Pixels in this situation, or close to it, are said to be 
"clipped". Of course its of paramount importance to avoid this situation, so as to preserve 
maximum detail in both shadows and highlights. To this end, the Histogram palette offers two 
visualization tools, both located below the Histogram chart. 
  

Clicking this icon , displays highlights that are already clipped or close to clipping. When all 
three color channels have reached their maximum, the corresponding clipped white zone is 
displayed as a false black on the image; when there is some information left in one of the color 
channels, the affected zone is displayed in other false colors. For additional information, you 



User guide 

35 

can hover on these zones and read the exact brightness values for each channel below the 
chart. 
  

The equivalent tool exists for the shadows: . In this case, clicking the icon will display, in 
false colors, the zones where no (or some) information is left in the color channels.  
Detecting the clipped zones can be of particular interest when you‘re trying to restore "burnt-out 
highlights" (see highlight recovery on Raw files), or when you‘re using DxO Lighting to "open" 
the shadows (see DxO Lighting sub-palette). 
  
Note: When you‟ve finished checking clipped zones and want to revert to the normal display, 

click the center icon  
  

 
The clipping of highlights, displayed in false colors, is made visible on the right-hand image 
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EXIF palette 

  
  

  
The EXIF Palette lets you add information to the EXIF data of the Output image 

  
The EXIF information palette consists of two parts: (1) Image properties, and (2) EXIF Editor.  
The "Image properties" list shows information written by your camera into the header of your 
image file. This information cannot be altered and will be saved "as is" when you create a 
corrected copy of your image. It is an important reference and can explain—in the event that 
some EXIF data are missing—why some optical defects are only partially corrected. This list 
shows the size of the image, exposure time, date of shooting, focal length, ISO speed rating, 
whether flash was used, the aperture, and the lens used. 
  
The EXIF editor lets you add an Author and Copyright information to the image, which will be 
stored in the EXIF data of the Output image (the EXIF data of the Source image will stay as they 
were). 
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Correction palettes 

About the correction palettes 

  
All the correction options available in DxO Optics in the ―Advanced user‖ workspace are 
controlled via five palettes. The first four palettes all view the image with a photographer's eye. 
―Light‖ covers everything about lighting and contrast in the scene, while ―Color‖ allows every 
possible chromatic modification. ―Geometry‖ is all about the overall structure of the image, while 
―Detail‖ goes down to pixel level, to increase sharpness and eliminate digital noise. The fifth 
palette "Tools" provides shortcuts to some tools from other palettes. 
  
Lastly, some film rendering options, as illustrated in this chapter, are available only if you have 
installed the optional ―DxO FilmPack‖ module.  
  
Note: Certain functions will only be enabled if the DxO Module for your lens and camera has 
been downloaded. If this is not the case, certain corrections will display as disabled and others 
will need to be adjusted manually. Likewise, the application of highlight recovery and high-
precision white balance setting (to the exact °Kelvin) is restricted to Raw files only. 
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Light palette 

Exposure compensation 

  
  
About exposure compensation 
  

 
In the left-hand image, a substantial part of the highlights, especially in the sky, were burnt-out. Using the 
"exposure compensation" sub-palette, with the setting "highlight priority - strong", allowed to recover 
strong details in the clouds, without darkening the image in the same proportion 
  

This correction adjusts the image exposure level, i.e. increases or reduces the brightness of 
each pixel in the image. Since a photographic system can only capture a fraction of the contrast 
range in the real world, most photos will have under- or over-exposed zones. With digital 
photography, overexposure is the most dangerous situation: above a certain level of light the 
camera sensor becomes "saturated" and returns an all-white pixel. So avoiding or correcting 
these "burnt-out" highlights — skies or specular reflections are common examples — is a 
constant concern. "Exposure compensation" and its "highlight recovery" mechanism are the 
tools you need for this.  
  
Exposure compensation will have more effect on  Raw images. Raw images have not yet been 
subjected to "White  balance", which in itself increases the brightness of the two least sensitive 
channels (red, blue). In highlight areas, these channels still contain some information, which can 
be used to reconstruct the information missing from the clipped channel.  With JPEG images, on 
the other hand, highlights that are lost — for whatever reason, including white balance, or any 
other in-camera exposure adjustment — are gone for good.  
  
Correcting a Raw file 
  

 
Three correction modes allow fine recovery of burnt-out highlights 

  
The "correction" drop down menu, which is specific to Raw images, offers four choices (plus a 
way back to the "manual" choice): 
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● The "Center weighted average‖ measurement optimizes the correction process (exposure 
adjustment) on the center of the image; 
  
● The three "Auto - Highlight priority" modes focus on highlight recovery, offering slight, medium 
and strong levels of recovery. When choosing between these levels, it is particularly advisable 
to check their effect by viewing the highlight clipping display, available under the Histogram 
display. Reminder: this button will display, in false colors to make them more visible, highlight 
zones that are close to, or have already reached, the clipping level, i.e. which are "burnt-out".  
  
In all the last three correction modes, the exposure slider is positioned automatically. You can 
also set it manually, over a range of −4 to +4 Ev (1 Ev corresponds to one f-stop). Moving the 
slider to the right will increase image exposure, while moving it to the left (or entering a negative 
Ev number) reduces it.  
  
Tip: choosing one of the automatic exposure options can speed up your workflow by providing 
custom settings for many types of shooting situation: usually, for example,“slight” correction is 
enough for a normally-contrasted image. Note that shadows will be automatically compensated 
when adjusting highlights, as long as DxO Lighting correction is enabled at the same time. 
  
  
Correcting a JPEG or TIFF file 
A single tool is available: a slider that lets you change the exposure from −4 Ev to +4 Ev (1 Ev, 
or "exposure value", is the equivalent of one f-stop). We recommend adjusting in small stages, 
monitoring the changes constantly on the histogram, with the "highlight clipping" button (on the 
right, below the histogram) "On". By viewing highlight clipping, you can easily see if the 
exposure has been increased too much (some clipped zones appear) or if it has not been 
reduced enough (clipped zones remain on the image).  
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DxO Lighting 

About DxO Lighting 

  

 
  
Backlit subjects are a typical use case for DxO lighting correction. Here, because of the very strong 
contrast, a high level of correction has been applied to "open" the shadows - as if a fill-in flash had been 
used.  

  
Ordinary image corrections apply to the whole photograph. With many applications, when you 
modify brightness or contrast, you make the whole image brighter, darker, more or less 
contrasted. But most of time you‘d really like to modify contrast or brightness of certain areas 
only. And that‘s exactly what DxO Lighting does — automatically. 
  
The aim of this correction is to change the local lighting, in terms of both brightness and 
contrast. This will allow you to ―dodge and burn‖ (i.e. to lighten or darken) certain areas only. It 
will likewise increase or reduce the contrast only where is needed. 
  
DxO lighting really comes into its own in the following cases: 
- images with areas that are backlit; 
- images with a contrast range markedly higher than a camera can handle; especially images 
with very dark areas; 
- images that were accidentally underexposed, generally short on contrast, or lacking a flash fill-
in. 
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DxO lighting: Basic settings 

  

 
The Auto mode of DxO Lighting has three levels, which should be sufficient for most photos 

  
  
As for many of our tools, DxO Lighting is by default in mode Automatic, where you will have 
nothing to adjust; the software will examine the image in detail, identify the areas that need 
correction, and apply it. 
  
If you would like to apply more or less DxO Lighting correction, you can use two adjustments, 
together or independently.  
  
● One modifies the strength of the correction: this is the drop-down menu with three choices: 
auto-medium (default), auto-strong and auto-slight.  
  
● The other one modifies the blending between the original image and the corrected image: 
70% is the default value, but it can be modified from 0% to 150%. 0% means that you use 0% of 
the corrected image and 100% of the original; at the opposite end, if you choose 100% on the 
slider, the resulting image will be made only with the corrected image. It is even possible to go 
beyond 100%: at 130%, for example, the resulting image will be made of 130% the corrected 
image and minus 30% the original.  
  
Note: of course, at any moment, if you click the "Auto" button at the right of the combo box and 
intensity ruler, you can revert safely to the automatic settings. 
  
  
Which settings should you use with DxO Lighting? 
DxO Lighting is probably the most complex of our corrections, since it implies both a local and 
global treatment; and an effect on both contrast and brightness; in other words, this correction 
influences all the parameters of the image, at the detail as well as the global level. Such a 
complex effect can only be learned by practice. But we can give you some clues all the same. 
  
First, the main effect of DxO Lighting will be apparent in shadows. This correction has little 
effect on highlights. (For these, see ―Exposure compensation‖). Generally speaking, DxO 
Lighting changes a high-key image only slightly, but has a more marked effect on a low-key 
image. 
  
Second, you should stick with the three pre-determined levels of correction as much as 
possible. Choosing between these already gives a wide choice. Once you have a good 
understanding of these pre-determined corrections, it will then be time to individually fine-tune 
your images (by clicking on ―advanced settings‖). The following sections deal with these 
advanced settings.  
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Third, you should take care to avoid interactions between DxO Lighting correction and other 
correction palettes or sub-palettes in DxO Optics Pro. The tone curve in particular has much in 
common with DxO Lighting: manipulating values in both could lead to complex situations.  
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DxO Lighting: Advanced settings 

  
  

 
DxO Lighting advanced settings manage black and white points, brightness and contrast 

  
Fine-tuning the brightness 
The Brightness correction applies mainly to shadows, less strongly to mid-tones and not at all to 
highlights. Therefore, its effect is to ―open the shadows‖ and, to a lesser extent, lighten the mid-
tones. It is activated by a slider named ‗Gamma‘, with a range of 0.10 to 10.00 . 
  
A side effect of this correction could be that a shadow area becomes lighter than a mid-tone 
area. To avoid such an unwanted effect, DxO Lighting has a built-in limiter: the ―Shadow radius‖ 
slider, with a range from 0 to 50. The larger the radius setting, the larger the areas of shadow 
that will be preserved from the brightness correction being applied. This slider is used in 
combination with another slider, the  "Preserve shadows" slider, which decides if the shadows 
defined by the "Shadow radius" slider will be preserved entirely (100), not at all (0) or in-
between. 
  
Choosing black and white points 
The ―black‖ point is the darkest point on the luminance scale that is transformed into an absolute 
black pixel. Similarly, the ―white point‖ is the most luminous point that is transformed into an all-
white pixel). This means that every pixel located below the black point will be black (and every 
pixel beyond the white point, white).  
  
Modifying the black or white point can be used when your photo does not extend to the entire 
width of the histogram. In this case, the black point is positioned above 0, and/or the white point 
below 255. Dragging them (to the left and right respectively) stretches the range of image 
luminance levels to occupy the whole of the available contrast rage, as very clearly shown on 
the histogram. 
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But even this classic modification must be applied very cautiously, to avoid clipping some minor 
values of luminance, or ending up with unwanted ―posterization‖ (inability of the image to display 
subtle changes in color). 
  
Fine-tuning the contrast 
  
Fine-tuning the contrast is performed by DxO Lighting in two very distinct ways:  
● Global contrast - This is the overall contrast of the image as a whole. DxO corrects this using 
a classic S-shaped tone curve: shadows and highlights are compressed and mid-tones 
expanded. The correction is activated by a slider with values −50 / + 50.  
Note: be careful, as this ―global contrast‖ correction can strongly interfere with the ―Tone curve‖ 
correction. 
  
● Local contrast- This is the contrast of small homogenous regions that have been delimited by 
the software. Enhancing it gives results that are somewhat similar to ―sharpening‖, without the 
pitfalls of the sharpening process – which inserts black and white pixels at the boundary 
between two distinct zones to enhance the contrast between them. Local contrast correction 
gives very subtle results that you can only see with a high degree of magnification. 
  
Note: Avoid using too much local contrast, especially in combination with “Unsharp mask” 
correction. 
  
Fine-tuning the color rendition 
  

If applying a preset created with DxO Optics Pro v6.2 or earlier produces different saturation 
with version 6.5.1 and higher, you may want to enable the ―DxO Lighting legacy (v6.2 and 
earlier) RAW color rendering‖ checkbox in the application preferences:  Preferences > General. 
(More about this preference) 
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Vignetting 

  
Vignetting is an optical aberration which results is less light falling onto the corners of an image 
than onto the center. The vignetting correction works differently and uses different commands 
depending on whether or not the relevant DxO Optics Module (profile) is available on your 
computer. 
  
If the DxO Optics Module is available 
In this case the "correction" box will display "Auto with DxO Optics Module" and the proposed 
correction will be automatic. You have the possibility to either fine-tune the automatic correction 
or go over to the wholly manual correction mode, as if no module were available (in this case, 
see paragraph below). 
To fine-tune the automatic correction, you need to understand its principle. The vignetting 
correction actually takes place in two steps, both of which can be fine-tuned. 
- First, from the lens data, focal length and aperture setting, the DxO Optics Module computes 
the attenuation factor for every pixel in the image, and each pixel‘s RGB value is multiplied by 
the inverse of this factor. The ―Correction Intensity‖ slider (range 0 to 100%) allows you to 
decide how much of the vignetting should be removed from the image. 
- Second, a filter is applied to avoid clipping in bright areas and noise increase in dark areas. 
This is achieved by limiting the value by which a pixel can be multiplied, according to its 
luminance. Clicking the ― Advanced settings ‖ box gives you access to the slider 
(‗Shadow/Highlight preservation‘) which sets the intensity of this filter, from 0 to 100%. Thus, if 
the filter is set to 0%, the vignetting correction will be applied without any restriction, while if the 
filter is set to 80%, very large highlights and shadows will stay uncorrected. Like with many 
other DxO Optics Pro corrections, the "Auto" button allows you to revert to the automatic setting. 
  

 
How the two sliders appear when the DxO Optics Module is available 

  
Note: When adjusting these two combined settings, we suggest sticking to the default 100% for 
the "Intensity" slider (the first of the two), since the "Shadow/Highlight preservation" slider is 
often more effective in preventing undesirable vignetting correction side-effects. Bear in mind 
that only vignetting due to the lens or sensor is corrected. Mechanical vignetting, caused for 
example by too narrow a lens shade, cannot be corrected. In the case of mechanical vignetting, 
you will want to use the crop tool to remove the unwanted parts of your picture. 
  
If the DxO Optics Module is not available 
In this case, the manual correction dialogue box will display. It allows you to adjust by eye the 
degree of lightening you want in the corners of the image. From ―Advanced settings‖ ―Mid-field 
amplification‖ you can select how far in towards the center the correction takes place. Be careful 
not to apply over-zealous correction: the corners of the image should not be lighter than the 
centre! 
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How vignetting correction lightens the corners of an image 
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Tone curve and levels  

  
  

 
The tone curve can be adjusted either channel per channel or globally  

  
About the tone curve 
The tone curve is a powerful, standard — though complex — tool. We recommend practicing a 
bit first before attempting to correct real photos. Note that many results obtained with the tone 
curve could have been obtained using the DxO Lighting sub-palette or the HSL sub-palette. 
  
The tone curve translates input tonal values (light received) to output tonal values (light seen in 
the image). The simplest case (see illustration above) is when the tone curve is a straight line 
ascending at 45° from the origin. Such a tone curve is neutral: every input value of light, whether 
in dark, medium or light tones, is translated into exact the same output value. Input values (from 
0, the darkest, to 255, the lightest) are on the x-axis, output values (similarly running from 0 to 
255) on the y-axis.  
  
Tone curves can be very subtly changed and redrawn, region by region, and even color by 
color, to suit a particular photo. Quite often, this takes the form of an "S-shaped curve". Such a 
curve compresses the dark shadows and strong highlights, but expands the mid-tones. This can 
often result in a more contrasty, "punchy" — and ultimately, pleasing — image. But once again, 
playing with the tone curve is not a matter of set recipes; this is a complex matter that takes 
practice and experience. 
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Drawing an S-curve, so called because of its shape, makes the image contrasty and „punchy‟ 

  
Modification of the tone curve 
  
Setting only the slope of the central part of the curve (the "gamma") is made by entering the 
slope value in the lower box, in the middle of the x-axis, set to 1 by default. Values can go from 
0.05 to 6.00. Values above 1 increase the contrast and bring out shadow detail. Values below 1 
reduce the contrast and bring out highlight detail. 
  
The curve is redrawn by defining and then moving points on the neutral curve (most often one 
point in the light shadows and one point in the first highlights, but more are possible). Points are 
defined by clicking on the curve. Where more than one point has been defined, one is active 
(shown by a black square), the other(s) inactive (white square). The active point can be deleted 
by right-clicking or pressing Delete. The active point can be dragged on the chart to modify the 
curve. 
  
The black and white points, on the x-axis and on the y-axis, can be modified either by dragging 
them along their axis, or by entering the desired value in the box adjacent to them.  
  
The combo box at the top of the Tone curve sub-palette lets you apply the tone curve either to 
all three color channels simultaneously, or channel by channel. Two reset buttons to the right of 
the combo box let you revert to the default neutral curve (straight line at 45°), either channel by 
channel, or for all three channels together. 
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Color palette 

Adjusting the white balance 

  
  
Whatever its origin (daylight or artificial lighting), light seems white to our eyes. But measured 
objectively, it is anything but! Even daylight can show strong bluish casts, especially in shadows 
or when the sky is cloudy. At the other end of the spectrum, incandescent bulbs have a well-
known yellowish cast, while all fluorescent lights display some complex greenish casts. 
Adjusting the white balance consists in correcting these undesirable hues. The aim is that a 
perfectly grey object (where all three primary colors are present in the same proportion) be 
rendered as a perfect, neutral grey.  
  
This setting will be different, depending on the type of image file. With a Raw file, the white 
balance has yet to be established, and you have absolute freedom of correction. With TIFF or 
JPEG files, on the other hand, the balance has already been established by the in-camera 
software; the range of correction is thus more restricted. 
  
Whatever your image file, two tools are at your disposal to adjust the white balance. One is a 
classic slider, and the other is a "color picker". We shall detail how to use this. 
  

Using the color picker   
The principle of the color picker is this: you use it to designate a zone in the picture which 
should be (but which is not yet) neutral gray. Then the software changes the global color 
balance so as to achieve, in this zone, a neutral grey. 
  
To use the color picker, you should find an area in the image that you know is a perfect, neutral 
grey: preferably a light grey, and certainly not an all-white, which can result in some unexpected 
corrections! Of course, for the moment this area will not be appearing as a perfect grey on your 
screen, so you have to know, by deduction or memory, that it is in fact grey.  
  
Once you have identified such an area, click on the color picker icon. The screen will display 
two images side-by-side. The left image is where you will click with the color-picker (which will 
replace the mouse pointer). The right image will show the result of the white balance you have 
chosen. This process will be easier if you zoom in on the image. 
  
Note that the color picker icon is available in both the "White balance" sub-palette and the 
"Tools" palette. 
  
Tip: The „Radius‟ slider at the bottom of the “image” pane lets you set the size of the sample 
zone. With images at high ISO settings, we recommend increasing the „radius‟ slider setting to 
10, to reduce pointing errors. 
  
Fine-tuning the white balance of a Raw file 
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Setting the white balance of a Raw file uses either presets, the "color picker", or a combination of two 
sliders 

  
Raw images, for which the white balance has not yet been established, offer the widest range of 
correction in this respect. One initial method is the color picker. Another is to use one of the 
presets defined in a drop-down menu: they suit the most normal situations, such as "Daylight", 
"Cloudy", "Shadow", "Tungsten", "Fluorescent", etc. A third method is to Click the ― Advanced 
settings ‖ box, and use the color temperature slider, which goes from 2,000 °K to 20,000 °K. 
This slider can often be combined with the second slider, titled "tint", which is intended to 
remove color casts. In all cases, going back to the ―As Shot‖ choice in the drop-down menu lets 
you safely revert to the settings given by the image EXIF data. 
  
  
  
Fine-tuning the white balance of a TIFF or JPEG file 
  

 
To set the white balance of JPEG/TIFF images, a simplified slider is available in addition to the color 
picker 

  
Strictly speaking, it's not possible to set the white balance for a JPEG or TIFF file, since the 
white balance has already been established by the in-camera processing. A tone curve has 
already been applied, so the pixels on the screen are no longer proportional to the input values. 
Therefore, any modification in one tonal range will induce imbalances in other tonal ranges: if 
we correct the midtone greys, then highlight greys or low-key greys will inevitably suffer a slight 
colored hue.  
  
This simpler correction (compared to a Raw file) can be done either with the color picker (see 
above) or by a slider, which allows "cooler" or "warmer" (bluish / yellowish) adjustments, and is 
accessible in "advanced settings". 
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Enhancing the vibrancy of your photos 

  
  

 
The vibrancy slider, a "smart" tool for modifying saturation 

  
While saturation (see "Color modes" and "HSL") is a correction affecting the whole image, 
"Vibrancy" involves the same mechanisms, but acts in a more restricted way, taking into 
account the colors already present in the image. It can be regarded as a "smart" color saturation 
setting. Vibrancy is set by a slider whose values go from −100 to +100. 
  
When the slider has a positive value 
In this case, the effect of vibrancy is to increase the overall saturation, with important 
restrictions: 
- flesh tones are corrected less than the image as a whole, to avoid red faces; 
- sky tones are corrected more than the image as a whole, and slightly darkened, to give them 
greater depth; 
- areas that are already close to gray are not corrected, to avoid a change of color balance. 
  
When the slider has a negative value: 
In this case, the effect of vibrancy is to decrease the overall saturation level, with these 
restrictions: 
- desaturation never goes down to zero (black and white image), unlike the more radical HSL 
corrections (see section below); 
- desaturation is more pronounced in the reds, which is useful for ‗rescuing‘ photos where the 
faces are too red and making flesh tones more natural. 
  
Note: be careful not to combine excessive vibrancy correction with an excessive level of 
saturation in the “Color rendering” correction. 
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Using the Hue, Saturation and Lightness (HSL) system 

  

 
Available channel by channel, the HSL correction is a powerful color correction tool 

  
Among the multiple systems used to describe the colored spaces, the HSL system (HSL stand 
for Hue, Saturation, Lightness) is well known for its effectiveness and simplicity. Each color has 
three parameters: its hue, its saturation and its lightness. This correction is available for each of 
the colored channels in an image: both the additive colors (RGB) and the subtractive colors 
(YMC: Yellow - Magenta - Cyan). 
  
The Hue slider has values from −180° to +180°: this is because Hue is classically illustrated as 
a circle on which all colors are located. Saturation can be moved from −100 to +100, and 
likewise for Lightness.  
The action of the Lightness slider is easy to understand if you look at its effect on the Histogram 
display. Moving the slider to the right shifts the black point to the right, compressing the tonal 
range into the upper half of the scale. Conversely, moving the slider to the left brings the white 
level down, towards black tones, compressing the tonal range into the lower half of the scale. 
The ―As Shot‖ button cancels any HSL correction. 
  
Note: If you want to correct several colors, we suggest you take a written note of the correction 
values used for each color layer, so that you can fine-tune a particular correction without having 
to start over again: moving a color just a few points can have a significant effect! 
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Creative multi-point color balance 

  
The usual rule in photography post-processing is that when you change one color, even slightly, 
all the other colors are affected. The multi-point color balance makes it possible to get round 
this, letting you change just one color without affecting the others. 
  
To transform a color, click on the multi-point balance tool. Your photo will display in two copies, 
one original, on the left, on which you will use the tool, and one for the corrected image on the 
right. On the left-hand image, click on an area containing the color you want to change. A wheel 
will display. This wheel has two controls: the rotating radius controls the color to which the 
selected color will be changed; and the small circle lying on this radius, which can slide from the 
center to the circumference of the circle, controls the degree of saturation: from 0 (at the center) 
to 100% (at the circumference of the circle). While you drag the pointer with the mouse, you can 
temporarily lock the hue by holding down the Ctrl key, or the saturation by holding down the 
Shift key. 
  
This control can be applied to up to four colors in the image, but if even you only want to change 
one color, it can be effective to click on adjacent colors to protect them from being affected.  
  
Tip: You might want to zoom in to a specific part of your image to make choosing the exact color 
point easier. You can zoom after you have clicked on the multi-point color balance icon. Use the 
“hand” tool to move around and display different portions of the image. One good way to try out 
this tool and learn how to use it is on blue sky. 
  
Controls and commands 
The dialog box displays four columns with: at the top, the source color (the original color); below 
this, the destination color (which you have chosen); and an X which is used to cancel this 
particular substitution. A color can be re-adjusted at any time by clicking in the centre of the 
selection point in the left-hand image. 
  
The ―Radius‖ slider changes the size of the zone used to pick-up the source color.  
  
The ―Intensity‖ slider lets you regulate the change made on the image: when the slider is set to 
0, 100% of the original image is kept, and no correction is applied; when set to 100%, nothing 
remains of the original, and the correction is applied at 100%. 
  
The ―Preserve White Balance‖ preserves grey tones from being altered by the correction, and 
moderates the effect of the correction. 
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On this image, four colors have been changed to four others (see the two rows of four squares above the 
slider) . 
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Geometry palette 

About the geometry palette 

  

 
  
The Geometry palette includes sub-palettes, corresponding to two settings and four 
adjustments; the two settings are : 
  
● Focal length (only shown when this data is approximate in EXIF data); 
  
● Focusing distance (only shown when this data is missing or incomplete in EXIF data); 
  
while the four adjustments are: 
  
● Distortion – corrects barrel and pincushion distortion; 
  
● Volume anamorphosis – corrects deformed faces or bodies; 
  
● Keystoning / horizon – corrects incorrect verticals or horizontals; 
  
● Crop – lets you center the image on its most interesting part. 
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Focal length and focusing distance 

  
The lens focal length and focusing distance of a photo are recorded in the EXIF data of your 
images. However, it can happen that this information is not recorded accurately enough. For 
example, different positions of the focal length ring (say, 17 or 18 mm) could result in the same 
value (say 18 mm) being recorded in the EXIF data. In this case, the distortion correction might 
be less than optimal.  
  
In the same manner, the focusing distance could be recorded in the EXIF data with insufficient 
precision, and similarly lead to an imprecise correction. 
  
In both cases, to improve the precision of your optical corrections, you should provide a more 
exact value in one (or both) of the rollups which will appear in the geometry palette: one for focal 
length, one for focusing distance. You will specify the focal length by setting a slider, and the 
focusing distance by selecting a range in a drop-down menu, then fine tuning with a slider.  
  
Remember: To be better alerted about insufficiently precise data, you could set, in the 
"Preferences", the icon   to "display", which then will appear on each thumbnail concerned. 
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Distortion 

  

 
The two major patterns of distortion: pincushion and barrel 

  
About distortion correction 
The geometric distortion introduced by a lens may be in pincushion or barrel form – or even 
sometimes a mixture of the two. In each case, the analytical measurements made by DxO Labs 
make it possible to correct the distortion in such a way that straight lines in the original scene 
are correctly reproduced as straight lines in the photo. The distortion correction has just one 
slider for the degree of the correction, with a range from 0 to 100%. The default setting is 100%, 
and you should only depart from this in special circumstances – either to avoid cropping of 
important detail near edges, or for creative reasons. 
  
The ―Correction‖ drop down menu allows you to select automatic correction based on a DxO 
Optics Module or manual correction. Only the manual option will be active if the DxO Optics 
Module is not available. 
  
Automatic correction of the distortion 
  

 
Provided the appropriate DxO Optics Module is loaded on your computer for the image you are 
working on, DxO Optics Pro will automatically perform the distortion correction on it. 
  
Manual correction of the distortion 
  

 
You will use the "Manual" choice in the drop-down menu if the DxO Optics Module needed is 
not available, or not loaded on your computer, or for creative reasons. In either case, first select 
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the type of distortion: "Fisheye" (for lenses of extremely short focal length, which produce a 
rounding effect on the whole image field), ―Barrel‖ or ―Pincushion‖ (two curved distortions of 
reverse effect - see image). 
  
Note: If you are correcting an image manually, it can be helpful to display a grid over it by 
clicking the grid overlay button   (fifth icon from the left in the "command" bar of the "Image" 
pane). 
  
Maintaining the aspect ratio or not 
Most of time, the distortion correction changes the "aspect ratio" (i.e. the ratio between the width 
and height) of the image. Since the aspect ratio is of great importance, especially if the photo is 
to be published, it is maintained by default, resulting in some cut-off of parts of the image edges. 
But if you accept to change the aspect ratio of the image, unchecking this box will allow to make 
use of a larger part of the image. On the other hand, to make sure that the whole of the usable 
part of the image is visible, you can uncheck this aspect ratio constraint by clicking the box at 
the bottom of the sub-palette. 
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Volume anamorphosis correction 

  

 
  
About volume anamorphosis 
Representing our three-dimensional world in a two-dimensional image raises a fundamental 
difficulty. The laws of optics cannot be overturned: when converted into a flat image, the shapes 
of certain 3D objects appear distorted and no longer correspond to what our eyes and brain 
expect to see. This phenomenon is referred to as ―volume anamorphosis‖. It is most noticeable 
and objectionable when using a wide-angle lens and/or when shooting objects in the 
foreground, close to the camera and near the edges of the image. 
  
The main difficulty, when trying to correct this distortion, is that it is entirely picture-content 
dependent. No automatic algorithm can be applied satisfactorily. Because any choice has its 
downfalls, only human correction, guided by experienced visual awareness, can produce a 
result that is pleasing to the eye. 
  
Choosing between spherical or cylindrical correction 
The first step in the correcting process consists in identifying the type of deformation. There are 
two of basic types: cylindrical and spherical. Basically, cylindrical objects (for example, columns 
or full-length human figures) need correction along one axis (most of time the vertical axis) more 
than another, which we refer to as ―cylindrical correction‖. To put it another way, a standing 
human body can be symbolized and represented by a cylinder. On the other hand, spherical 
objects (e.g. a human head) need correction on both axes simultaneously; this we call 
"spherical correction".  
  
The volume anamorphosis correction sub-palette contains a drop-down menu from which you 
should choose between cylindrical or spherical correction. You can then fine-tune the amount of 
correction with the "Radial intensity" (or ―Horizontal/Vertical intensity") slider (in "Advanced 
settings"). The slider takes any value between 0 and 200%. We advise you to apply as little 
correction as possible. Using a grid overlay on the image will often prove very helpful. 
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The corrected photo (right) shows the effect of the volume anamorphosis correction on human bodies and 
faces, compared to the strong deformations in the original image (left).  
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Keystoning / horizon 

  

 
  
About horizontal and vertical distortion 
Two kinds of distortion can affect verticals or horizontals. One is simple, the other complex. The 
simple one is a tilted image: the horizon line is tilted by a few degrees because, at the time of 
shooting, the photographer has tilted the camera by a few degrees. Such tilting can likewise 
result in a prominent vertical (a tree, a pole, a column) being tilted by a few degrees from its 
normal position. The solution to this problem is as simple as the cause: rotating the image in the 
opposite direction by as many degrees as it has been tilted. 
  
Keystone distortion is much more complex. This happens whenever the camera is not square-
on to its subject. The most well-known case is photographing a building. If the building is low, 
and shot from some distance, you will frame it without difficulty, the camera will stay roughly 
parallel to the facade, and no distortion will occur. But if the building is taller, and the 
photographer stands closer, the camera will have to be tilted up to frame the whole facade. In 
this case, all parallel lines on the facade will be transformed into converging lines: the building 
will look as if it is falling backwards. The same phenomenon will happen to horizontals if the 
camera is angled in the "left/right" direction instead of "up/down". And of course the effects of 
both distortions may combine if the camera is tilted in both directions at once. In such a case, 
the corrections are complex; they imply the need to reconstruct some missing pixels (and 
therefore to lose some detail) and to modify the rectangular shape of the image, thereby losing 
some picture content. 
  
Note: the name keystone comes from the fact that this distortion transforms a rectangle into a 
trapezium, which is the shape of a keystone in traditional stone-masonry. 
  
Horizon tool 

This simple tool allows you to correct a defective horizon automatically, by the desired angle, 
without time-wasting trials. Click on the tool, then draw a line on the skew-whiff horizon: click to 
establish a first point, hold down the mouse button and then click to mark a second point. The 
line between the two points will display in bright green, then the image will rotate automatically 
to place the line at a perfect horizontal. This process can be undone (Ctrl-Z). A more traditional 
way of setting the desired rotation is to use the Rotation slider (from −180° to +180°) or to enter 
the desired rotation angle into the box.  
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The same process can be used to correct a vertical line which has deviated from its usual 
position. 
  
Tip: Using the “Toggle Grid Overlay”   can help make it easier to adjust the squareness of the 
image. 
  
  

 
Using the "horizon tool" on a line known as horizontal avoids the trial and error process of adjusting the 
photo's horizontality  

  
Advanced: the keystone distortion tools 
  
These tools are accessed by clicking the ―Advanced settings‖ box. The sub-palette will then 
expand to display two additional buttons and slider controls. 
  

At the top are two buttons and , which control keystoning using either parallels or a 
rectangle. 
  
● Clicking on the first tool ("Force parallels") will display two similar images of your photo. You 
will mark the correction in the left-hand image and see the result on the right-hand one. To apply 
the correction, draw two lines, on picture elements that you know are parallel (e.g. two columns, 
two sides of a door or portal, two angles of a facade).  
  
● Clicking on the second tool ("Rectangle") will likewise display two images of your photo. Then, 
clicking anywhere in the left-hand image will display a rectangle, of which you will drag 
successively all four corners on a form that you wish to become a perfect rectangle: a window, 
for example. This tool will have a much more drastic effect, since not only will the two verticals 
become parallel, but the two horizontals as well. Therefore, the Rectangle tool  strongly modifies 
the perspective of your image. You should use it for small degrees of correction, when the 
camera has been slightly tilted from its desired position.  
Note: these commands can also be accessed via the shortcuts on the Tools menu 
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The ―Up/Down‖ and ―Left/Right‖ sliders give you additional fine control for adjusting vertical or 
horizontal keystoning correction, with both sliders having a range of −125 to +125. They act as if 
the shooting plane were tilted forwards / backwards about a horizontal axis ("Up/Down" slider); 
and as if the shooting plane were angled to the left / right about a vertical axis ("Right/Left" 
slider). Also note that you can type in a value, instead of using the sliders, for even more precise 
control of these functions. 
  
Note: The perspective corrections are complex and require both an understanding of the optical 
process and a strong visual sense. But, when appropriately applied, they can significantly 
enhance your photos: not only architectural images (which obviously will benefit from them the 
most, but even portraits or landscapes. 
  
  

 
Converging verticals (above) are made parallel thanks to the "Force parallels" tool, but that comes at a 
price: losing parts of the image, which must be cropped 

  
Advanced: modifying the dimensions or proportions of your image 
The ―Scale‖ slider lets you resize the image (from 50% to 200%) while maintaining its 
proportions. 
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The ―Horizontal / Vertical ratio‖ slider lets you stretch or squeeze the height of your image while 
keeping the width unchanged. The scale runs from −100 (50% of the original height) to +100 
(200% of original height). Using this tool will change the visual proportions of the subjects in 
your picture and can result in severe distortion. 
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Crop 

  

 
  
Automatic cropping 
An image whose perspective has been corrected by the "Keystoning / horizon" tools generally 
loses some information at the edges – a great deal more if the correction is significant. This is 
why, by default, the ―Crop‖ box is set to ―Auto‖ and the aspect ratio to ―Unconstrained‖, meaning 
that cropping is performed automatically on the corrected image, retaining as much information 
as possible, even if the price paid is to change the original proportions. 
  
Selecting ―Preserve aspect ratio‖ in the drop-down menu instead of "Unconstrained" will resize 
your image while maintaining its proportions (i.e. the relationship between its longer and shorter 
sides: for example 3:2 or 4:3). It‘s also possible to set a different ratio chosen from the drop-
down, like 1:1 (the square Rolleiflex or Hasselblad format), and even to set your own particular 
ratio, like 5:4 (replicating the traditional 5×4 or 10×8 format) or any other, by entering its two 
figures, separated by a slash, in the lower box.  
  
Manual cropping 
If you select manual cropping, a dotted crop box will display on the image. You can move or 
extend this box by dragging its corners. If you have chosen a specific aspect ratio, the box will 
display the proportions of this aspect ratio, and you will be allowed to change only one of its 
dimensions, the other tracking automatically. If you have chosen an unconstrained aspect ratio, 
you will be able to freely change both dimensions of the box. 
  
To adjust a crop you can also click on the Crop tool button. Once Crop has been enabled, select 
a point in the image, hold down the left mouse button and drag to create a crop box: it will 
appear as a black rectangular frame within the image. Clicking on and dragging the corners of 
the box adjusts its size. Clicking inside the box lets you move it around. Clicking outside the box 
removes the box and lets you create a new box from scratch. 
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Detail palette 

About the detail palette 

  

 
  
The "Detail palette" brings together corrections involving your images at the smallest scale, but 
which will have a very strong impact on their visual quality. One feature common to all these 
corrections is the absolute necessity to judge them with a zoom factor of at least 75%. The 
reason for this is not only that zooming in will make your judgement of corrections easier.  The 
main reason is that the image you look at during the Customizing process is a simulation, which 
is much faster to compute than the definitive image. Unfortunately, none of the corrections in the 
Detail palette can, for technical reasons, be simulated. They can only be effectively computed. 
Therefore, to avoid intensive computing which would slow the display, DxO Optics Pro only 
computes small fractions of the whole image, this limit being above a zoom factor of 75%. 
  
There are five of these corrections: 
● "Lens softness" and "Unsharp mask" are two different ways to deal with the same optical 
defect: softness or lack of sharpness; 
  
● "Noise" addresses the grainy appearance of all images shot at high ISO speeds, or simply of 
underexposed zones; 
  
● "Chromatic aberration" makes it possible to eliminate magenta, purple or green artifacts 
appearing at high-contrast edges in the image; 
  
●  The more classic "Dust tool" lets you erase accidental dust spots on your photos. 
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Lens softness 

  

 
  
About lens softness 
Lens softness is an optical aberration which results in a point being transformed by the lens into 
a small blurred circle instead of a point. This should not be confused with out-of-focus or motion 
blur, which DxO Optics Pro is unable to deal with. DxO Optics Modules have been created by 
measuring, for each camera body and each lens, the amount of blur at every point in the image 
area. Matching the shooting parameters contained in the EXIF data (aperture, focal length, etc.) 
and the map provided by the DxO Optics Module, DxO Optics Pro can apply precisely-tailored 
correction according to the position of each pixel in the image field. This correction is not the 
same over the whole image, since lenses are sharper in the centre, therefore central pixels 
need less correction. This correction is one of DxO Optics Pro‘s great strengths. 
  
Note: this sub-palette will only be visible for images for which the appropriate DxO Optics 
Module is loaded. If no module is available, you should use the "Unsharp mask" sub-palette to 
adjust the sharpness manually. 
  
The "Global" slider 
An average setting has been defined by DxO Labs for the "Global" slider, which corresponds to 
the ―−0.5‖ position. 
  
Negative settings, from −2 to 0, do not represent softening or un-sharpening of the image: they 
simply correspond to a lower level of correction (the corrected image will always be at least as 
sharp as the original image). The 0 level has some degree of sharpening compared to the 
original photo. To reduce overall sharpness correction (for a portrait for example), move the 
―Global‖ slider to the left; to increase it, move the slider to the right.  
  
DxO lens softness correction is a ―smart‖ correction, which limits its effects in noisy areas of the 
image or when the ISO setting is high.  
  
Note: For JPEG images, it‟s important not to increase the sharpness of a shot that has already 
been sharpened by the camera. Hence, when you intend to post-process your images, you 
should shoot without any in-camera sharpening. 
  
  
The "Detail" slider 
The ―Detail‖ slider is set at 0 by default. It is used to enhance the micro-contrast of fine details in 
the image. This subtle correction can be very worthwhile in the case of landscapes, but should 
be reduced to a minimum for portraits, where a certain degree of softness, hiding for example 
skin blemishes, is generally desirable. Note that enhancing details with the "Lens softness" tool 
does not create white edges around the sharpened areas, as the ―Unsharp Mask‖ does. 
  
Lens softness and Unsharp mask 
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It is recommended that you perform as much of your sharpening as possible using the Lens 
Softness correction before using the Unsharp Mask (USM) which, although a sophisticated and 
adaptive tool, is a more standard process, since it applies the same corrections to all pixels. Of 
course, for images where the appropriate DxO Optics Module is not installed, all sharpening will 
have to be done using the USM. 
  
  
  

 
Automatic lens softness optimization in a corner of a Raw image 

  
Note: since "lens softness" correction is much more subtle in its effects, and much more 
adapted to your particular equipment than the "Unsharp mask" process, we recommend that 
you use the latter very sparingly. (Assuming, of course, that the correct DxO Optics Module is 
available). 
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Sharpening using an "unsharp mask" 

  

 
  
About the "unsharp mask" technique 
Contrary to what its name seems to announce, the "unsharp mask" technique aims to sharpen 
an image. The technique — which dates from the days of film processing — consists in making 
a blurred copy of the original, then subtracting the original from the blurred copy, the result of 
this subtraction being the finest details, which are then enhanced. 
Unsharp masks are characterized by three parameters: 
- the intensity of the correction; 
- the radius, which sets how thick the edges of one detail can be; 
- the threshold, which decide which details (those above the threshold) will be sharpened, and 
which (those below the threshold) will be left as they are; this makes it possible, in particular, to 
avoid sharpening the smallest details, which are just noise. 
  
Using the "unsharp mask" 
The ―Unsharp Mask‖ correction is disabled by default. It is unnecessary on JPEG files when 
they have already been sharpened by the in-camera processing. And it is usually unnecessary 
for Raw images for which a DxO Module is available. This means its use is really confined to 
unsharpened JPEG files and Raw files without a DxO Optics Module. For the latter, it would 
even be advisable to fine-tune the "unsharp mask" settings, then create a preset.  
  
Fine-tuning the three sliders can often be done using these starting values: intensity 100, radius 
0.5, threshold 4. Threshold, with most images, should stay in a rang from 4 to 10. Radius 
determines how subtle the correction is: excessive values will result in haloes. Finally, the 
"Intensity" slider can be set up to 200. 
  
Note: the left values on the Intensity slider are negative (from −100 to 0) and these do result in 
softening, instead of sharpening, the image.  
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Manual sharpening (displayed at 100%) for an older lens (1970) for which no DxO Optics Module is 
available 
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Noise 

  

 
  
About noise in digital photography 
All digital cameras suffer from noise to a certain degree. Noise is characterized by random 
variations in an area that ought to be uniform. For example, if you shoot a uniform grey target, 
your image will show variations from this grey: both in luminance (some pixels darker or lighter 
than they should be) or in chrominance (some pixels colored instead of grey). Having a 
relatively constant amplitude, noise is much more of a problem in shadows (where the 
luminance signal is low), than in highlights, where it is relatively weaker in comparison to the 
luminance signal. Noise is aggravated by the use of high sensitivities (high ISOs), since setting 
a higher sensitivity amounts to amplifying the image (and hence amplifying the noise with it). 
  
About DxO noise reduction 
The extremely powerful DxO noise suppression module is not an all-purpose algorithm. It is 
based on measurements made on each camera by DxO Labs and is therefore tailored for this 
model of camera. Accordingly, if your camera isn't supported by DxO Optics Pro (i.e. hasn't 
been calibrated), you will have to manually adjust the two sliders (―Luminance‖ and 
―Chrominance‖) which make the denoising process effective. 
  
A second limitation is that JPEG images, which will already have been treated by an in-camera 
noise reduction tool, have in the process lost a certain amount of their details, which will not be 
recovered. Accordingly, the quality of noise correction that DxO Optics Pro can perform on a 
JPEG image is substantially lower than for a Raw image, from which no detail has been lost. 
This is a strong argument for shooting Raw files. 
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An example of automatic noise suppression on a Raw file at 6,400 ISO 

  
  

  
An example of manual noise reduction on a Raw file at 25,600 ISO 

  
Fine-tuning the noise reduction 
Since it is applied in accordance with scientific measurements made on your camera, DxO 
Optics Pro's automatic correction provides a very efficient basis for removing noise. Fine-tuning 
can be made via 3 sliders: 
  
● The first two sliders, "Luminance / Detail" and "Luminance / Contrast", often provide the most 
visible correction. Their range goes from 0 to 100%. They both remove the grain of the original 
image. But while the "luminance detail" slider takes care of high-frequency noise (that is very 
small details), the "luminance contrast" slider removes larger unwanted noise effects, such as 
relatively large stains which can effect skin. 
  
If you want to set these sliders, take care not to reach the point where some surfaces have lost 
their "natural" appearance and look ―plastic‖. 
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● The "Chrominance" slider is necessary to remove colored noise (speckles of unwanted color, 
like yellow on flesh tones, or blue on grey tones), to which the eye is particularly sensitive, and 
here you can use higher settings with little risk of unwanted side effects. 
  
● Opening the advanced settings first gives access to gray correction (enabled by default). The 
―Gray equalizer‖ slider / entry box has a range from 0 to 100%. Its effect complements the 
"Chrominance noise" slider. It slightly desaturates colors in the midtone range. You will probably 
leave this correction at the default setting unless you notice undesirable effects (e.g. excessive 
desaturation). 
  
Finally, two checkboxes enable 
– a special ―Remove dead pixels‖ algorithm to eliminate ―dead pixels‖ – sensor elements that, 
for whatever reason, fail to record the incident light correctly, showing up as bright spots on the 
image. This happens mostly at a high ISO settings and is fairly invisible at lower speed ratings. 
  
– an "anti-moiré" filter. Moiré is a disturbing phenomenon which takes places when some 
surfaces (silk, feathers, for example) have minutes details which cause interferences. 
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Dust 

  

 
  
  
This anti-dust tool allows you to ―paint‖ a line (whose thickness can be adjusted) or to position a 
dot (of variable diameter) over a dust spot or any unwanted detail you would like to erase. If the 
spot has affected many photos, it can be useful to correct one of them, and then create a preset 
from these settings which will be applied to others. 
  
Clicking on the tool displays a dual image: original on the left, corrected on the right. You should 
then zoom in on the image, and set the width of your tool. Then position a spot or draw a line at 
the desired place (drawing results from clicking, then dragging while holding down the mouse 
button. To remove an unwanted correction, click on it again with the tool and press the "Delete" 
key. To remove all corrections made on the image, press the "reset" button, below the left-hand 
image.  
  
Note: This tool can only work if your image is displayed with a 75% factor at least  
  

 
Each blue dot in the original image will be corrected in the processed image (right). 
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Chromatic aberration 

  

 
  
About chromatic aberration 
Chromatic aberration results in different colors focusing at slightly different places. If these 
places are spread along the image plane, they are called lateral. If they are spread along a 
plane perpendicular to the image plane, they are called longitudinal. In all cases, chromatic 
aberration leads to very visible defects, which can be readily seen at the edge between two 
contrasting areas. "Purple fringing", which is mostly due to chromatic aberration, is a particular 
phenomenon, in which a ghost-like image, purple in color, appears at some highly contrasted 
edges. 
  
Correcting chromatic aberration 
● The lateral chromatic aberration (e.g. magenta or green fringes beside a straight line) is 
automatically corrected only if the appropriate DxO Optics Module is available. In this case, no 
setting is necessary. 
  
● The other types of chromatic aberration (longitudinal or other) are automatically corrected 
under the control of two sliders: 
- One sets the intensity of the correction, with a range of 0 to 200; 
- The other, with a range from 0 to 12 in arbitrary units, adjusts the width of the colored fringe 
that will be suppressed: this affects the way DxO Optics Pro decides what is chromatic 
aberration that needs to be corrected, and what is real picture content. 
  
● The Purple fringing correction is applied by checking a particular box. One should check it for 
all backlit scenes, or when shooting with a lens prone to this optical defect.  
  
Note: Overall chromatic aberration correction must be enabled for this function to become 
available. 
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Correcting chromatic aberration and purple fringing on a backlit scene: a frequent necessity 
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DxO FilmPack palette 

About DxO FilmPack palette 

  
This palette displays if the additional DxO FilmPack plugin has been activated. It allows to 
smoothly integrate the various film emulations or editing tools provided by DxO FilmPack to your 
usual work with DxO Optics Pro. Five sub-palettes are at your disposal: 
  
– Color rendering. This sub-palette is a duplicate of the Color rendering sub-palette in the 
Color palette. It allows to emulate either a camera body, an ICC profile, or a very large variety of 
films, both positive and negative, color and black-and-white. (See more). 
  
– Color modes. This sub-palette is a duplicate of the Color modes sub-palette in the Color 
palette. It allows to apply various styles of monochrome (toned or black-and-white) emulations, 
and various colored filters.  It also contains specific color profiles (landscape, etc.) and allows to 
set contrast as well as saturation. (See more). 
  
– DxO FilmPack grain. This sub-palette allows to apply a specific grain (from more than sixty 
films, color as well as B&W) and to set its size.  (See more). 
  
– Channel mixer. This sub-palette (only available in the ―Expert‖ edition) allows to manually 
adjust the balance between the six main colored channels. Its frequent use will be to obtain, 
from a color file, a superior black-and-white version.  (See more). 
  
–  Creative vignetting. This sub-palette (only available in the ―Expert‖ edition) raises or lowers 
the amount of light received on the periphery of the image. It allows, in particular, to ―frame‖ and 
enhance the image center.  (See more). 
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Color rendering 

Color rendering 

  

 
  
Every camera (which really means every sensor), every type of processing software, and for 
traditional photography, every film, has a particular color rendition, which for some of them is 
part of their reputation. The purpose of this "color rendering" correction is to simulate on the 
image you have shot the same effect as if it had been shot with camera X or film Y. 
  
This correction has two possible uses. One is purely esthetic, enabling you to use such and 
such a "color rendering" to suit the characteristics of the photo. One could, for example, use the 
color rendering of a Kodachrome film for an advertising image which would evoke the kitsch 
atmosphere of the 1960s. 
  
Another use of the correction is more linked to practical needs: many photographers, working 
with two or three cameras concurrently, want to give to their work a uniform appearance — that, 
for example, of one of their cameras. Or they want to deliver to their customer very neutral sets 
of images, which, on the contrary, bear no visible signs of any camera. In all these cases, the 
Color rendering correction will provide you with a tool to circulate from one color space to 
another. 
  
For JPEG or TIFF photos 
  
Like other corrections, this one is inherently limited when applied to TIFF or JPEG images (as 
opposed to Raw ones): these images have already been processed by a Raw converter, and no 
access to the original data can be recovered. 
  
If you have not activated the optional DxO FilmPack plugin, this emulation will be limited to a 
short list of well known positive color films: Fuji Velvia, Kodachrome, etc. But if you have 
activated DxO FilmPack (see how), you will have access to more than 60 films to emulate (see 
below for a detailed list). 
  
These variations are accessed by a combination of the two drop-down menus. The "intensity" 
slider allows a progressive blending of the original image and the image changed into another 
color space. At 0, only the original image appears, at 50 half the original is mixed with half the 
corrected image, at 100 only the corrected image, and above 100 the image is "hyper-
corrected". This slider has of course no effect if the first drop down menu is set to "Defaults 
settings (RAW: factory, RGB: body)". 
  

https://shop.dxo.com/login.php
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For Raw images 
  
Raw images, since they still contain all the luminance information and have never been 
converted into any color space, are particularly suitable for this correction. 
  
● The basic rendering, as displayed by default on your screen — in the menus, we call this 
"Default settings (RAW: factory, RGB: body)" — is the one that your camera maker has 
calculated when he generates a JPEG image; most of the time, it is quite saturated and 
contrasty.  
From this starting point many paths are open: 
  
● The "Camera body" choice, in the first of the two drop-down menus, gives access, in the 
second drop-down menu, to: 
  
– Four "neutral color" settings, which differ slightly only in the shape of their tone curve, hence 
their level of contrast. Of these, the "neutral color, neutral tonality" setting will be our reference, 
since this will be the common bridge to circulate from any color rendering to any other. 
  
– A long list of cameras, which have been tested and measured by DxO Labs, and of which you 
can use the color rendering. 
  
● The third, fourth, fifth and sixth choices in the first menu ("Color positive films", "Color negative 
films DxO FilmPack" "Black & white films DxO FilmPack" and "Cross-processed films DxO 
FilmPack" – the last three choices are only visible/accessible if DxO FilmPack is activated) 
open, in the second menu, a list of some famous films which you can emulate. The larger part of 
these films is available only if you have activated DxO FilmPack. (See below for a detailed list of 
these films, and here on how to activate DxO FilmPack). 
  
● The last choice in the first menu ("ICC profile") opens a dialog box, in which you can browse 
your file system to find some color profile that you might want to use. Let‘s remember that an 
ICC profile is a set of data which characterize any visual device (a camera, a screen, a scanner, 
etc). 
  
As with JPEG or TIFF images, an "intensity" slider allows progressive blending of the original 
image and the image changed into another color space. At 0, only the original image appears, 
at 50 half the original is mixed with half the corrected image, at 100 only the corrected image, 
and above 100 the image is "hyper-corrected". But note that with Raw images, the "original 
image" is not the one displayed by default (this one is a "simulated JPEG" of your photo), but 
the "neutral image" which serves as a bridge to all changes of color rendering. 
  
The “Protect saturated colors” cursor 
  
You should use this cursor to prevent some specific saturated colors from being clipped which 
may lead to unnatural colors and loss of texture. This may happen when a particular color 
channel is close to the minimum or to the maximum luminous intensity (0 or 255). Setting this 
cursor to a certain level will ensure that the value of this color doesn‘t go below 0 or above 255, 
and therefore remains natural. 
  
DxO FilmPack emulated films 
More than 60 films can be emulated with DxO FilmPack : color-positive films, also said reversal 
films, intended to produce transparencies; color-negative films, intended to produce prints; 

https://shop.dxo.com/login.php
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black-and white films; and finally cross-processed films, which are films developed in a 
chemistry not normally suited to their nature. 
  
● Color positive films 
  
Fuji Astia 100F : the more color-neutral of transparency films made by Fuji.  
  
Fuji FP 100 C : An instant film by Fuji , ISO 100 sensitivity, compatible with Polaroid 689 films. 
  
Fuji Provia 100F : Vaunted by Fuji as having ―the smoothest and sharpest performance of any 
100 ISO color film in the world‖, Provia has effectively become a natural choice for many 
professional photographers. Less saturated than Velvia, it will be more suited to studio and 
portrait photography.  
  
Fuji Provia 400F : A remarkably fine-grained film for this level of sensitivity. 
  
Fuji Provia 400X : The successor to Provia 400 F, with enhanced saturation. 
  
Fuji Velvia 50 : The Velvia range of transparency films was introduced in 1990. Its extreme 
resolving power and fine grain made it a direct competitor to the Kodachrome series, with easier 
to use chemistry (E6). Many discussions took place as to whether Velvia‘s saturated colors 
were more or less ―true‖ than Kodachrome ones. The fact remains that Velvia enjoyed 
considerable commercial success and was considered by many as the newer reference in 
transparency films. 
  
Kodak Kodachrome 25 : The successor to Kodachrome II, and thus in a direct line from the 
original Kodachrome, launched way back in 1936. This legendary product is the first color film 
ever intended for the mass market. To reconstruct colors, it used a subtractive method designed 
by Godowsky and Mannes. Its sharpness, extremely realistic colors, and archival stability would 
amply make up for its drawbacks: very low sensitivity and a complex developing process.  
  
Kodak Kodachrome 64 : From 1974 onwards, the successor to Kodachrome-X; both had the 
notable advantage of allowing shooting with 1½ stops less light than the original Kodachrome 
25. 
  
Kodak Kodachrome 200 :  The only high-sensitivity member of the Kodachrome family (1986).  
  
Kodak Ektachrome 100 VS : While Kodachrome was the reference in outdoor photography for 
both professionals and advanced amateurs, Ektachrome has for half a century remained the 
reference for studio photography. Easier to expose, available in a wide range of sensitivities and 
formats (including the largest formats of sheet film), and much easier to process (the E series of 
process chemistry was manageable even by a skilled amateur), Ektachrome became a byword 
for transparencies in general. The 100 VS is one of its ultimate versions, with ―vivid and 
saturated colors‖ (Kodak). 
  
Kodak Ektachrome 100 GX : A less saturated version of Ektachrome than the 100 VS, with 
warm skin tones and extremely fine grain. 
  
Kodak Elite ExtraColor 100 : A highly saturated transparency film, well suited to the 
contemporary taste for vivid colors. 
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Kodak Elite Chrome 200 : The consumer version of Ektachrome films, also to be developed in 
the E6 chemistry.  
  
Kodak Elite Chrome 400 : This film is described by Kodak as producing ―rich and vibrant colors 
even in dim daylight conditions‖.  
  
Polaroid Polachrome : A transparency film for instant development. One had to buy a small 
device, hand-powered, which would develop each image in a couple of minutes, after which the 
photo was mounted. 
  
Polaroid 669 : A peel-apart Polaroid medium-format film for instant prints, ISO 80. Has also 
been unofficially employed for transferring photos onto paper or fabrics. 
  
Polaroid 690 : A higher sensitivity version (ISO 100) of the above film, both belonging to the 
large ―Type 100‖ series. 
  
Generic Fuji Astia 100 : This emulation corresponds to a very early version of DxO FilmPack 
when film calibration was performed differently from the way it is today. The calibration process 
has been improved since: see ―Fuji Astia 100‖. 
  
Generic Fuji Provia 100 : See above. 
  
Generic Fuji Velvia 100 : See above, with regard to both generic emulations and the Velvia 
range. 
  
Generic Kodak Ektachrome 100 VS. See above, with regard to both generic emulations and the 
Ektachrome range. 
  
Generic Kodak Ektachrome 64 : See above, with regard to both generic emulations and the 
Ektachrome range. 
  
Agfa Precisa 100 (DxO FilmPack Expert version only) : A reputed transparency film by Agfa, 
which was developed in the AP44 chemistry (a clone of E6 chemistry). 
  
Fuji Sensia 100 (DxO FilmPack Expert version only) : The consumer version of Fuji Astia.  
  
Lomography X-Pro Slide 200 (DxO FilmPack Expert version only) : A revival of famous Agfa 
RSX II transparency film, with its saturated colors, extra-wide contrast, and distinctive tint when 
cross-processed. 
  
● Color negative films 
  
Agfa Ultra 100 : Appeared in 2003, this film has very high saturation. 
  
Agfa Vista 200 : An all-purpose film, with a eye-pleasing color rendering and wide exposure 
latitude. 
  
Fuji Superia Reala 100 : The Superia brand was aimed at mainstream amateurs, while the 
Reala range used pioneering technology (a fourth sensitive layer) to achieve improved white 
balance. The combination has been well appreciated by expert photographers. 
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Fuji Superia 200 : A direct competitor for Kodak‘s Gold, this is the member of the Superia family 
with the finest grain. 
  
Fuji Superia X-Tra 800 : The fastest multi-purpose film in the Superia range. 
  
Fuji Superia HG 1600 : The high-sensitivity film in the Superia range, was used, for example, in 
concert photography by advanced amateurs. 
  
Kodak Elite Color 200 : This range of consumer films was intended to give a relatively strong 
level of saturation ―without sacrificing skin tones‖. 
  
Kodak Elite Color 400 : The high-sensitivity member of the Elite Color range described above. 
  
Kodak Portra 160 NC : Aimed at professionals shooting portraits or marriages, this film has 
been constantly praised for the quality of its skin tones, and the fidelity with which it reproduces 
clothing. Has rapidly become a classic among classics. NC stands for ―neutral colors‖. 
  
Kodak Portra 160 VC : The ―vivid colors‖ (VC) member of the Kodak Portra family. 
  
Lomography Redscale 100 (DxO FilmPack Expert version only) :A very creative film, whose 
strong orange effect is produced by exposing the negative on the reverse side. 
  
● Cross-processed film 
  
Cross-processed - Kodak Elite 100 : 
  
Cross-processed - Fuji Superia 200 :  
  
● Black-and-white films 
  
Agfa APX 25 : Agfapan 25, now discontinued, was a famous film made by Agfa. Its grain was 
one of the finest ever, with a nominal sensitivity of ISO 25. It was used for decades for shootings 
where a long exposure time was not critical, such as landscape or microphotography. It appears 
here in its APX version, which was Agfa‘s answer to Kodak‘s T-grain series. 
  
Fuji Neopan Acros 100 : This film prided itself on delivering ―the world's highest standard in 
grain quality among ISO 100 films‖. 
  
Fuji Neopan 1600 : A high-speed ISO 1600 film that has been prized for the ―classic beauty‖ of 
its grain.  
  
Ilford Delta 400 : Introduced in 1990, this is the first film based on Ilford‘s ―core-shell crystal 
technology‖, the company‘s answer to Kodak‘s T-grain films: more sensitive crystals without a 
higher grain.  
  
Ilford Delta 3200 : The ultra-high-sensitivity product in the Ilford range, based on their ―core-shell 
technology―. A direct competitor to Kodak‘s T-max 3200.  
  
Ilford FP4 Plus 125 : A workhorse of classical photography, this film was available in many 
formats, including sheet, and has been characterized by Ilford as ―unrivalled (... for) its very fine 
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grain, outstanding sharpness and high acutance (... with) enormous latitude for exposure error 
above and below its nominal sensitivity‖. 
  
Ilford HP5 Plus 400 : A classic, and the arch-rival of Kodak T-Max, it has been characterized by 
Ilford as a ―medium contrast film (...) especially suitable for action and press photography (... 
which) has been formulated to respond well to push processing and film speeds up to (ISO) 
3200‖. 
  
Ilford HPS 800 : A lesser-known ultra-high-speed film, the ISO 800 HPS was removed from the 
range in the late 1960s. It was replaced, years later, by the Delta 3200. 
  
Ilford Pan F Plus 50 : In 2004, the Ilford company described this as ―an extremely fine grain 
black and white film with outstanding resolution, sharpness and edge contrast‖, well suited to 
mural size enlargements. Its moderate contrast was appreciated by many. 
  
Ilford XP2  : Just like its rival Kodak BW 400CN, this ISO 400 film, which comes in both 135 and 
120 formats, has the advantage of being developed in any easy-to-find C41 processing lab. 
  
Kodak BW400CN : Praised as ―the finest-grained chromogenic film in the world‖ by its maker 
Kodak, this film is actually not comparable to ordinary B&W films, since once developed, it no 
longer contains silver crystals, but dyes instead. The major advantage of Kodak BW400CN is 
that it can be developed in an easy-to-find C-41 process.  
  
Kodak HIE (High-speed infrared) : Infrared light, not visible to our eyes, can be captured by 
specially-designed films. This famous film, now discontinued, was difficult to expose, focus, and 
develop. But the creative images it would record were often worth all the trouble. 
  
Kodak HIE filtered : Many infrared images were recorded using a dark red or even a black filter, 
which would block the visible radiation, letting only the infrared wavelengths reach the film. The 
resulting images showed dark skies, black water, and a kind of aura around highlights. 
  
Kodak T-Max 100 : The least sensitive film in Kodak‘s T-Max range, with ISO 100 (pushable to 
200) sensitivity and very fine grain. A classic. 
  
Kodak T-Max 400 : The standard for fast B&W films, this one had found the perfect combination 
of speed and grain. A favorite among reporters.  
  
Kodak T-Max 3200 : With ample reserves of sensitivity (2 stops, to 12,500), 3200 has been 
used both for low-light press photography and for surveillance purposes.  
  
Kodak Tri-X 400 : A vintage look, and an illustrious list of achievements. 
  
Polaroid 664 : A classic Polaroid film, medium speed (ISO 100), mainly intended for proofing on 
studio shoots. 
  
Polaroid 667 : A very high speed (ISO 3000) black-and-white panchromatic film, often used for 
scientific purposes. 
  
Polaroid 672 : The ISO 400 reference in the Polaroid range.  
  
Rollei IR 400 : A recent ISO 400 infrared film. 



DxO Optics Pro v6.6 User Manual - Windows 

84 

  
Ilford Delta 100 (DxO FilmPack Expert version only) : A tabular-grain film, with exceptionally fine 
grain, sharpness, and wide exposure latitude.  
  
Rollei Retro 100 tonal (DxO FilmPack Expert version only) : Available in 120 and sheet format, a 
high-quality film for experienced photographers and professionals.  
  
Rollei Retro 80s (DxO FilmPack Expert version only) : Like the Retro 100, this extremely fine-
grain film is made by Rollei in partnership with the Maco company. This particular film is derived 
from a film intended for aerial photography. 
  
Rollei Ortho 25 (DxO FilmPack Expert version only) : Mainly intended for scientific and copy 
work. This film has extremely fine grain with a 2-stop sensitivity reserve. 
  
Agfa APX 100 (DxO FilmPack Expert version only) : Mainly intended for non-moving subjects 
(architecture, landscape, still-life), this very high quality film is mostly used by professional 
photographers. 
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Color modes 

  

 
  
The content of this sub-palette depends on the activation or non activation of the optional DxO 
FilmPack plug-in. 
  
1. DxO FilmPack not activated 
  
This correction gives access to four presets, which influence overall contrast and saturation. 
They are based on four classic situations and will allow you to quickly apply a basic combination 
to your images. After one of these four settings has been applied, it is still possible, and indeed 
advisable, to fine-tune its effect with the "contrast" and "saturation" sliders. 
  
The four presets are: 
- As Shot (default value); 
- Landscape; 
- Portrait; 
- Black and white (default B&W conversion of a color image);  
- Sepia toning (see more in the ―Toning section‖ below) ; 
  
The ―Contrast‖ slider lets you adjust the overall contrast of the image. 
  
The ―Saturation‖ slider lets you move from −100 (totally desaturated colors, i.e. black and white) 
to fully saturated colors (+100). 
  
2. DxO FilmPack activated 
  
The DxO FilmPack plug-in, if activated, gives access : (1) to a large choice of Toning options in 
the Style and Toning section; and (2) to an additional Filter section. 
  
● Toning options  
  
About toning 
In a conventional photographic print, the image is formed by silver crystals: the more numerous 
or the bigger these crystals, the darker the image. 
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Toning is a very old process which substitutes these pure silver crystals with various metallic 
salts, or even silverless dyes. Its purpose is both aesthetic (more subtle midtones, darker 
shadows) and practical (in some cases, toning ensures better preservation of the image).  
  
Choosing your toning 
The drop-down menu lists the following options, each of which can be blended with the original 
image by using the ―Intensity‖ slider: 
– Black and white: the standard B&W version of your image, resulting from DxO FilmPack‘s 
default mixing of colored channels. To adjust this default mixing, you should use the Channel 
mixer.  
– Ferric sulfate: gives a grey-green appearance.  
– Gold: this toning used gold chloride; it strongly enhanced the permanence of prints, and gave 
them flattering metallic blue blacks.  
– Selenium: a classic toning, used mainly for the purpose of print permanence. Gives a light 
color change, mostly in the range of purples.  
– Sepia terra: see sepia below. 
– Sepia gold: see sepia below. 
– Sepia: Albumen images in the 19th century had a natural sepia tint. When albumen came out 
of use, in the 1880s, many photographers came to tone the new gelatin silver prints in sepia, 
both to protect them better and to make them look like the older prints. Today, sepia in general 
has become a visual synonym of ―old photo‖. DxO FilmPack has three varieties of sepia toning: 
the classic one, which is the darkest; sepia terra (lighter); and sepia gold: a light sepia toning 
with some colder (blue) notes. 
  
  
● Filter section 
  
About filters 
Front-of-lens photographic filters fall into three categories: 
– Correction filters, used only with color films, change the color temperature of the light to suit 
the film, e.g. allow daylight shooting using a film intended for incandescent lighting (filter 85B) or 
the reverse (filter 80A or B); 
– Effects filters, used only with B&W films, bring about various effects, like the ultra-classic 
yellow-tinted Wratten 8 filter, which absorbs blue, thereby revealing detail in skies and raising 
the general contrast of the image. More generally, a filter absorbs the complementary color of its 
own color: the former is reduced, the latter enhanced.  
– Polarizing filters block certain incoming rays according to their plane of vibration; this cannot 
be emulated digitally. 
  
Choosing a filter in the drop-down menu 
– Cool tone: used to moderately reduce the proportion of ―warm‖ incoming light (in the red-
yellow range), thus increasing the proportion of ―cold‖ tones.  
– Blue: gives a foggy and unreal atmosphere to landscapes. 
– Green: since trees can appear excessively dark on many photos, this filter will lighten any 
foliage. 
– Yellow: a classic filter, to slightly increase the density and quality of skies and bring out 
clouds. 
– Orange: All orange filters will strongly darken skies, and increase differentiation between 
many objects of similar intensity but different colors: for example, flowers and foliage. The 
stronger the orange, the more pronounced the effect will be. 
– Bright orange (DxO FilmPack Expert version only); 
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– Light orange (DxO FilmPack Expert version only); 
– Dark orange; 
– Red: a very powerful filter, giving extreme, dramatic effects with very dark skies and overall 
violent contrast. 
– Mauve (DxO FilmPack Expert version only); 
– Cyan (DxO FilmPack Expert version only); 
– Bright Cyan (DxO FilmPack Expert version only); 
– Purplish Blue (DxO FilmPack Expert version only); 
– Purple (DxO FilmPack Expert version only); 
– Bright Orange (DxO FilmPack Expert version only); 
– Light Orange (DxO FilmPack Expert version only); 
– Brown (DxO FilmPack Expert version only); 
– Pink (DxO FilmPack Expert version only); 
– Magenta (DxO FilmPack Expert version only). 
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DxO FilmPack grain 

  

 
  
About film grain 
  
Within a photographic emulsion, silver crystals or dyes are grouped into clusters of various sizes 
and shapes. These in turn produce random variations of luminous intensity: the larger these 
clusters, the stronger these variations, and the more grainy the emulsion appears. 
  
Grain is directly linked to sensitivity: a more sensitive film (a film with a high ISO) has larger 
clusters of silver halides, which stand more chance of being modified by the incoming light and 
then being transformed into metallic silver or dyes (the final photographic product). 
  
It wasn‘t until the 1980s that T-grain films became available, in which a new form of silver 
crystals (tabular) allowed higher sensitivity with no increase in grain. 
  
Applying a film grain 
  
– Let us first remember that the grain is applied separately from the tonality: if you have chosen 
to emulate the tonality of an Agfapan APX 25, then selected ―Kodak T- Max 3200‖ in the film 
grain sub-palette, your image will actually have APX 25 tonality with T-Max 3200 grain. 
  
– In most cases, the effect of grain will be barely visible at low magnifications. 
  
– Applying film grain will give far better results if you have previously removed noise from 
image, either in the host application or in the DxO FilmPack ―Noise removal‖ sub-palette.  
  
Setting the grain size 
  
To satisfactorily emulate film grain, we need to take into account the ―enlargement‖ the negative 
would have been undergone when printed in a traditional processing chain: if the same size of 
grain is applied to two negatives, one of small format (24×36 mm) and one of large format 
(4×5‖), and each negative is then enlarged up to a 15×12‖ print, the magnification will have been 
3:1 for the sheet film, and more than 10:1 for the 135 film. Obviously the smaller format will 
appear much grainier. 
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To take this variable into account, DxO FilmPack has a ―Negative size‖ menu, placed under the 
main ―Film grain‖ menu. Negative sizes can be set to 24×36 mm, 6×6 cm (medium format) or 
4×5‖. The enlargement rates, and thus the size of the final grain, are proportional to the chosen 
negative size. If you would like to choose a custom negative size, choose Custom format in the 
drop-down menu, and use the slider under the menu to set the desired enlargement rate.  
  
Note: if you have cropped your image, and wish to set the enlargement rate according to your 
actual image size (after cropping), you should tick the box at the bottom of the Grain subpalette. 
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Channel mixer 

  

 
  
Note: The Channel mixer is available in DxO FilmPack Expert version only. In addition, it is only 
relevant for B&W images. Color images should be converted to B&W before using this tool.  
  
The ―Channel mixer‖ lets you define the quantity of each color channel to be taken into account 
to generate the B&W image, and therefore make objects of some certain colors stand out (or in 
the opposite, fade out) in the B&W image. It allows to play on any of the additive colors (RGB : 
red, green, blue), and any of the subtractive colors (CMY : cyan, magenta, yellow).  
  
You could think of the Channel mixer as a more customizable set of colored filters. While the 
filters in the filter sub-palette are a limited set of colors and intensities, the Channel mixer allows 
to enhance or reduce any combination of colors at any intensity. 
  
If you think that the contribution of any of the color channels is too high (or too low), push the 
corresponding slider one way or the other, or type in the desired value, or increment 
(decrement) the displayed value by clicking on the +/− signs. Proceed by small steps.  
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Creative vignetting 

  

 
  
Note: The Creative vignetting sub-palette is available in DxO FilmPack Expert version only. 
  
Vignetting, in its traditional meaning, occurs – due to lens shortcomings – when more light 
reaches the center than the edges of the image, resulting in darker zones at the periphery. 
  
But what is basically an optical defect (and is corrected in a particular sub-palette of DxO Optics 
Pro) can also be used in a creative way. Vignetting can be digitally accentuated, by reducing the 
luminosity of peripheral zones (making them darker). This technique, often used by 
photographers in the past (though without the help of digital techniques...), focuses the attention 
on the subject at the center of the image.  
  
The Creative vignetting sub-palette provides tools to adjust vignetting by increasing or reducing 
the luminous intensity of peripheral zones: 
  
– The Intensity slider can be set in both negative and positive directions. A negative value will 
make peripheral zones less luminous, while a positive value will raise vignetting (darken the 
same zones) and create a frame around the center subject. 
  
– The Midpoint slider will determine at which distance from the edge the vignetting effect will be 
effective. A small value will make the effect – whether lightening or darkening – appear close to 
the edge only; while a higher value will increase the vignetted zone, bringing it closer to the 
center.  
  
– The Roundness slider will determine the shape of the vignetting effect (whether lightening or 
darkening): positive values will produce round shapes (the higher the value, the more rounded 
the shape), while negative values will produce rectangular shapes. 
  
– The Transition slider determines how sharp the transition between the vignetted and the non-
vignetted zone will be. High values will make a clear-cut transition, while low values will make a 
blurred transition. 
  
Note: Since the creative vignetting is always added ―post-crop‖, it is recommended to always 
enable the optical vignetting correction, to ensure lighting uniformity. 
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Tools palette 

  
  
The ―Tools‖ palette is composed of seven icons which are shortcuts to the corresponding sub-
palettes and have exactly the same purpose and functioning: 

● The Crop icon gives access to the "Crop" sub-palette in the ―Geometry‖ palette ; 
  

● The Dust removal tool icon  gives access to the "Dust" sub-palette in the ―Detail‖ palette 
(see details); 
  

● The Horizon, Force parallel and Rectangle icons   are those of the ―Keystoning / 
Horizon‖ sub-palette in the ―Geometry‖ palette. 
  

● The Multi-point color balance  gives access to the ―Multi-point color balance‖ sub-palette in 
the ―Color‖ palette; 
  

● The color picker  gives access to the ―White balance‖ sub-palette of the ―Color‖ palette. 
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Using presets 

About presets 

  
A ―preset‖ is a list of corrections, where the status of each correction is mentioned as either 
 disabled or enabled — in the latter case, enabled with a certain parameter. For example, 
―Exposure correction‖ can be either disabled or enabled ; if it is enabled, a degree of correction 
must be specified, e.g. ―−2‖, meaning ―−2 stops‖. 
  
Two sorts of presets exist in DxO Optics Pro. ―Full presets‖ cover all the existing corrections, 
meaning that they give to each correction a status (―enabled‖ or ―disabled‖), and if enabled, a 
parameter (e.g. ―-2‖ for the exposure correction). ―Partial presets‖, on the contrary, cover only a 
limited number among all existing corrections. For example, a Partial preset could give no status 
to the ―Exposure correction‖: neither enabled nor disabled. You can see that any correction can 
in fact have three positions : enabled, disabled, or undecided. 
  
An important feature of DxO Optics Pro is that as soon as an image is included in a Project, a 
Full preset (i.e. covering all existing corrections) must be associated to it. This preset can be 
either the software‘s default preset ("DxO default v2"), or a preset that you have chosen. 
  
This chapter covers the following topics : 
  
● a description of the ready-to-use presets, which DxO Optics Pro is supplied with;  
  
● how presets are applied, and how they combine with each other;  
  
● how you can create and edit a preset adapted to your needs. 
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Ready-to-use presets  

  
  

  
One of the ready-to-use presets: the “Landscape postcard” preset 

  
More than 20 presets are supplied with DxO Optics Pro. They can be accessed from the drop 
down menu to the right of the ―Add to Project‖ button in the ―Select‖ tab; or by right-clicking on a 
thumbnail in the ―PROJECT‖ pane; or else via the ―presets‖ drop down menu in the ―Customize‖ 
tab. Some are grouped within sub-folders, some appear at the higher level of the presets folder.  
  
● DxO default v2 preset is applied by default to all images imported into DxO Optics Pro. It lists 
all the basic corrections. In the ―Light‖ palette, Lighting is set to ―slight auto‖, Vignetting to ―auto‖. 
In the ―Color‖ palette, color rendering is set to ―unchanged‖ for JPEG images, and to the ―default 
camera manufacturer color rendering‖ for Raw images. In the ―Geometry‖ palette, Distortion is 
set to auto. In the ―Detail‖ palette, Lens Softness is set to ―enabled‖; the ―Global‖ slider is set to 
−0.5 (i.e. average correction) and the ―Detail‖ slider set to 50; Chromatic Aberration is set to 
auto (with lateral chromatic aberration enabled) and DxO Noise is set to auto. All other 
corrections are disabled. This preset affects all the settings (Full preset).  
  
Note: when a session is started, the preset appearing at the top of the drop-down menu (and 
which will be applied in the absence of any positive choice) is the most recently selected preset 
(before the software was last shut down), which may or may not be the ”DxO default v2” preset.  
  
● DxO default - Original (v1) used to be the default preset up to DxO Optics Pro version 6.2. It 
differs from ‗DxO default v2‘ in that the Lens Softness ‗Global‘ and ‗Detail‘ sliders are both set to 
0. This preset affects all the settings (Full preset) 
  
● DxO default v2 – Neutral color (RAW only) is identical to "DxO Default v2" except for the color 
rendering, which has lower saturation and contrast in order to achieve very faithful reproduction. 
This preset affects all the settings (Full preset). It is recommended for professional 
photographers. 
  
● The ―Color and contrast‖ folder includes 15 different presets: 
 
— Natural colors (Raw only): Produces natural colors to render the colors in a scene as 
faithfully as possible. Suitable for most Raw photos if you prefer a fairly natural color rendering. 
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— HDR effect: a creative preset, which uses the settings of the Light palette only, to show the 
maximum of potentialities hidden in the image. 
  
— General – Vivid colors: A ―creative‖ preset, well suited for landscapes, architecture, still life 
compositions and nature photos if you like strong contrast and saturated colors. 
  
— General – Negative colors: Gives the appearance of a negative film. 
  
— General – Black and white. Automatically tailored to the content of the image. Uses only the 
Color palette settings.  
  
— General – Ancient photo. Uses only the Color and the Light palette settings to give the effect 
of faded colors. 
  
— Landscape – Postcard: Boosts color saturation and contrast.  
  
— Landscape – High key: Strongly reduces the density while preserving detail and highlights. 
Useful for misty landscapes, photos of the sea in the morning, or romantic portraits. 
  
— Landscape – Low key: Reduces the overall level of exposure while increasing contrast. Very 
effective for urban landscapes, industrial buildings or ―distorted‖ nature photos. 
  
— Highlight recovery – slight, medium or strong (Raw only): for high-dynamic-range scenes with 
highlights that are burnt out but still contain useful detail (cloudy sky, snow fields, wedding 
dress, candles, open fire, etc.). 
  
— Realistic color variation 1, 2, and 3 (Raw only): These three presets offer three other color 
rendering variations to produce colors to your taste. 
 

● The ―Detail adjustment‖ folder includes four presets: 
  
— Fine details – raises the sharpness for all details in the image. 
  
— Color anti-aliasing (Raw only) – Eliminates areas of colored moiré. Very appropriate for 
photos of clothing with regular patterns or any other objects with a fine, regular structure. Also 
ideal for photos of hair, fur or feathers. 
  
— Fine grain (Raw only) – keeps a very fine grain for all photos shot in low light, or at high 
ISOs, or a combination of both. 
  
— High ISO – noise reduction: At very high ISO settings, gives the best compromise between 
noise reduction and preserving detail and dark shadows. For all photos shot in low light or at 
high speed or a combination of the two. Also for night and indoor action photos shot without 
flash. 
  
● The ―Geometry adjustment‖ folder includes two different presets: 
— Maximize the scope of sight – For images with strong levels of distortion, especially in the 
edges. Recovers the maximum of information, at the price of cropping some parts of the image 
and changing the aspect ratio. 
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— Group portrait (option: restore face proportions): When faces away from the image centre 
appear distorted. For group photos shot using a wide-angle lens with multiple faces right across 
the image. 
  
— Group portrait (option: restore body proportions): Restores the proportions of bodies that look 
distorted and fatter at the edges of the image. For group photos shot using a wide-angle lens 
with several people standing next to each other in a line. 
  
● The HDR single-shot folder includes three different presets:  
  
— HDR artistic (Raw only). This creative preset gives a very strong HDR effect to Raw images, 
without the need for multi-exposure shooting. Recovers the highlights, strongly opens the 
shadows, modifies the tone curve and the vibrancy. 
  
— HDR light. This creative preset can be applied to both RAW and JPEG images. It gives them, 
without the need for a multi-exposure shooting, a slight HDR effect. Uses the settings of DxO 
Lighting only. 
  
— HDR realistic (Raw only) This creative preset gives a strong HDR effect to Raw images (but 
nos as strong as the HDR artistic preset listed above), without the need for multi-exposure 
shooting. Recovers the highlights, strongly opens the shadows, modifies the tone curve and the 
vibrancy. 
  
● No correction: This preset disables all DxO Optics Pro corrections. Nevertheless, when 
applied to a Raw image, this preset will let DxO Optics Pro perform the Raw conversion (using 
the camera settings). This preset affects all the settings (Full preset). 
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Applying presets 

  
Applying a preset to an image is not an option. It is a basic rule which must fulfilled to allow the 
image to enter your "Project pane". Therefore, the first way to apply a preset is a passive way: 
the simple fact of adding an image to a project subjects this image to the default preset ("DxO 
default v2").  
There are other, "active" ways of applying a preset to an image: 
- before adding the image into a Project, by choosing another preset in the drop-down menu of 
the ―Select‖ tab; 
- by right-clicking on a thumbnail in the ―PROJECT‖ pane at any time 
- from the ―presets‖ drop-down menu on the icon bar in the ―Customize‖ tab 
- from the ―preset Editor‖ palette 
  
Note: When adding an image to the project, if you use a preset you‟ve selected instead of the 
default preset ("DxO default v2"), and if this chosen preset is a partial one (i.e. does not cover 
all the corrections), all the corrections with no assigned value will be set to the “DxO default v2” 
preset value. This will allow the principle to be satisfied that a value (even the value "disabled") 
is mandatory for each correction. 
  

How presets combine with each other 

  
When an image enters your project, and you decide that no particular preset will apply to it, this 
image will be governed by the default preset ("DxO Default v2"). This preset has been designed 
so as to cover all possible corrections and to give a value to each one. (Remember that even 
"Disabled" is a value). Even the apparently minimalist "No correction" preset, which appears in 
the drop-down list, also covers all possible corrections – though in a simple way: by assigning 
'Disabled" to all. Hence both these presets — one very active, one totally inactive — both satisfy 
our principle: all the corrections must have a value. These are full presets. 
  
Now, what if we have a photo governed by "DxO default v2" (or by any other full preset) and we 
want to apply another preset on top of this? If each of them has a value for a given correction, 
how will they compete? What will happen if only one preset gives a value for a given correction? 
The rule is simple: The preset applied last will prevail. If the first-applied preset gives a value of 
"Disabled" for a correction, and the second "Enabled", then that correction will be active. If both 
set it to Enabled, the first with value "−2", the second with a value "+1", then it is the value "+1" 
that will be applied.  
  
This, in particular, makes it possible to build "partial presets": based on a limited range of 
corrections, they will be applied on top of "general purpose" presets. When a correction is 
covered by the partial preset, it will be governed by it. Where the partial preset is silent, the 
correction will be governed by the underlying preset. 
  
Note: since some settings (e.g. highlight recovery) are only available for Raw images, presets 
that govern these specific settings alone are flagged accordingly (“Raw only”) in the drop-down 
lists, and will have no effect on JPEG files.  
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Advanced: setting the underlying preset 

A frequent conflict of priorities comes from this situation: you apply "DxO Default v2" as a 
starting point to an image; then you fine-tune your corrections (for example, setting the white 
balance or color temperature precisely); then, you would like to apply a partial preset (say, to 
take care of noise with high ISO speeds). How will all this combine? The rule is this: the last 
applied preset (here, the "denoise" preset) will govern all corrections that it involves. All the 
others will be governed by your settings at the time the last preset was applied. But in such 
cases, if you specifically want to apply the newer preset on top of "DxO Default v2" instead of 
your present corrections, you could go to the menu command Edit > Preferences > Display, and 
check the third item from top in the "Common" section. This will from now on display a screen 
which will let you choose between your current corrections or "DxO default v2" as underlying 
values. 
  
Tip: The undo command (menu Edit > Undo) and its shortcut Ctrl -Z lets you undo the 
immediately-preceding preset application and revert to the previous setting. 
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Creating presets 

  
There are two ways to create a preset. Either you will fine-tune the corrections on a particular 
image, then save this set of corrections as a new preset; or you will start from scratch, without 
the support of a particular image, and use the ―preset editor‖ to give a value to each setting (see 
details in the next section). Obviously, the second way is much more suited to experienced 
users.  
  

Create a preset based on current settings 

This is one of two methods you can use to create a preset, and is the most accessible to an 
inexperienced user. 
  
This function is accessed either by right-clicking on any thumbnail in the PROJECT pane, or (if 
you are working under the ―Customize" tab) from the ―presets‖ drop-down menu. In either case, 
all the settings associated with the image will be saved in a preset that you will have to name, 
then save.  
  
The preset you have created in this manner will affect all setting values: it is a Full preset. 
  

Create a preset using the preset editor 

See next section ("Preset editor") for details. 
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Preset editor palette 

  

 
The "Preset editor" palette allows to create a preset from scratch and choose each one of its settings 

  
The ―preset editor‖ is one of the palettes available under the ―Customize‖ tab. To display this 
palette, either choose the ―Advanced user‖ workspace, in the choice of workspaces (last drop-
down menu at the right of the command bar of the "Customize" tab); or check ―preset editor‖ in 
the drop-down menu (next-to-last menu) of the same upper command bar. Both choices will 
make the ―preset editor‖ palette appear, docked at the left of your screen, close to the image 
checking palettes. Click on the ―preset editor‖ palette itself to display its contents. 
  
  

Create a preset using the preset Editor 

  

Click on the ―New preset‖ icon . This creates a preset named ―New preset‖ in the current 
preset directory. Change its name (click on the default ―new preset‖ name and type the name 
you want). We now have a preset with a name but no settings inside it yet.  
  
To edit the desired settings, click on the ―Preview / Edit‖ button or in the menu displayed by right 
clicking on the new preset's icon. A vertical bar of orange boxes will display to the left of all the 
sub-palettes. The principle on which the editor is based is this:  
  
● If you check a sub-palette in the orange column, this palette will be incorporated into the 
preset:  
  
— if it is not checked in the grey column, it will be considered as "disabled". Note that a disabled 
correction is not at all the same thing as a correction with no value. Setting the "distortion 
correction" as disabled, for example, means that you have actively decided not to apply this 
correction. Setting "no value" means that you have made no decision, which is different and has 
different effects.  
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— if it is checked in the grey column, it will be included as "enabled", and accompanied by the 
values that are displayed. 
  
● Now, if you uncheck any sub-palette in the orange column, this correction will have no value 
in the preset, regardless of whatever is set in the grey column — which is quite different from 
having a value "disabled", as explained above. A preset with at least one unchecked sub-palette 
is called a "Partial preset", and when applied to an image must be combined with another preset 
so that all sub-palettes have a value. 
  
  

 
An orange bar displays at the left of each setting when the "Edit" mode of the preset editor palette is 
activated. 

  
Once you are finished editing, save your preset by clicking ―Save‖ and click on ―Preview / Edit‖ 
again to exit the edit mode and remove the bar of orange boxes. 
  
Don‘t forget to click on the ―Apply‖ button to associate this preset with your image. Otherwise, 
you would have edited and saved a preset but not applied it to your image. 
  
You can create as many presets as you want, save them to folders and then import them into 
other versions of DxO Optics Pro and export them to share with other users of the software. 
  

Previewing / applying / canceling a preset 

  
The usual method of applying a preset to an image (whether a single image, a stack or a multi-
selection) is to use the command ―Apply a preset‖, which you find either in the right-click menu 
— on the thumbnail or on the image — or in the traditional menu (Image > Apply a preset). You 
then navigate in the presets folders to locate the desired preset. 
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The preset editor adds a third way to apply a preset. But its most interesting feature is to allow a 
preview of the preset to be applied. This happens by choosing a preset in the catalog, then 
clicking the ―Preview / Edit‖ button. Once your choice is made, click on the ―Apply‖ button.  
In all cases, the choice of a preset can be undone by the usual command ―Edit > Cancel‖ or its 
shortcut Ctrl-Z.  
  
  

Details of all commands in the preset Editor palette 

● The New folder icon  creates a folder in which you can group similar presets: by type of 
camera used, high speed rating, landscape rendering, portrait, etc. presets can be moved from 
one folder to another using drag-and-drop. 
  

● The New preset icon  creates an ―empty‖ preset — one that contains no settings. An empty 
preset needs to be edited. NB: If a folder has been selected before you create your preset, it will 
be created in this folder; 
  

● The Copy icon  makes it easier to create a preset by using an existing preset. You will 
need to use this method if you want to create variants of a locked DxO preset; 
  

● The Delete icon  deletes the selected preset or folder; 
  

● The Import icon  lets you import presets created previously in other versions of the 
software, or available on another computer. Clicking on the icon opens a folder in which you will 
search for the file(s) you want to import; 
  

● The Export icon  makes it easy to export a preset to a folder which will be copied onto 
another computer or sent via e-mail.  
  

● Finally, the icon ―Create new preset from image‖  uses all the settings of the current 
image to create a new preset. 
  

Using the presets folders 

Folders appearing in the list can be opened by either double-clicking, or a single click on the 
triangle to their left, which will fold / unfold them. 
  
Clicking on the name of a folder lets you rename it, just like you rename a file. Depending on 
how you name a new folder, it will be automatically placed above or below the default preset 
folder. We would recommend that you give your folders meaningful names, so that you can 
easily group and find your presets.  
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Virtual copies 
  

  
The "create a Virtual copy" commands displays this window. One action is required: typing a suffix. One 
(choosing a preset) is optional, since you can use the current settings as the settings to apply to the 
Virtual copy. 

  

About Virtual copies 

Testing different corrections, or different levels of a single correction, is a complicated task. In 
traditional photo darkrooms, it was usual, for the sake of an interesting image, to sacrifice some 
sheets of sensitive paper and print some copies of a same negative with different settings in 
exposure time, contrast, dodging, etc. DxO Optics Pro offers the same level of convenience and 
experimentation with the "Virtual copy". 
  
A Virtual copy is a duplicate of a Source image, which will let you try alternative correction 
settings. You can create as many Virtual copies of the same Source image as you want, to 
apply many different correction settings and compare them.  
  

How to create Virtual Copies 

If you want to make Virtual copies of the image "image1.cr2" (cr2 is a raw format file for Canon 
cameras), select "image1" in your Project, then press the command "Create Virtual copy", which 
you will find either in the "Image" menu, or in the drop-down menu that displays on right-clicking 
on the image itself. A pop-up window will ask you to choose a suffix for the image, which will 
help you differentiate your Virtual copy from its Source image (and from its other Virtual copies). 
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For example, if you type "+ some contrast" the copy will be named "image1.cr2 (+ some 
contrast)". Note that the suffix appears between parentheses and after the file extension. 
  
You also have the choice of the Correction Settings to be applied to this Virtual copy: either you 
apply all the Correction Settings of the Source Image (which you will likely fine-tune for the 
Virtual copy), or you can apply a preset that you choose from the drop down menu. 
  
Now click OK. Your Virtual copy is ready and displays in the "Project" pane, like an ordinary 

image, the only difference being the Virtual copy icon image  
  

Using a Virtual copy as the "Reference image" 

 
  
  
The previous steps have shown how to make different Virtual copies (in fact their number is 
unlimited), which can all be compared, one at a time, to the Source Image. But you might want 
to go one step further and compare Virtual copies between themselves. To this end, it will be 
necessary to process the image that you want to use as Reference Image. Then display the 
image, and in the first group of icons from the left on the "command" bar of the "Image" pane, 
click the drop-down menu. The names of all Virtual copies of the Source Image will display, 
some greyed (because they have not been yet processed), some active. Choose one image 
from the latter set. This image is now the Reference Image, and will display on the left when you 
compare images of this group side by side. In this way, any Virtual copy can be compared 
directly to any other, without having to use the Source Image as a necessary third party. 
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Step 3- the Process tab 

About the process tab 
  

  
The process tab will process some or all of the images from the project pane (below); each image will be 
corrected in as many formats as required by the "output settings panel" (on the left) 

  
The processing procedure in itself is simple: when you press the "Start processing" button, all 
images in the "PROJECT" pane — or only those images you select — will be processed, i.e. 
corrected, according to the settings that accompany each image. Then a corrected version 
(always distinct from the Source Image), with a new name, will be stored in the desired format, 
in the desired folder. 
  
The additional power provided by DxO Optics Pro at this stage is just that — it offers the user a 
versatility of output choices, while maintaining fully automatic processing. 
  
In default mode (this is the mode that you will use when processing images for the first time), 
DxO Optics Pro provides a basic output solution. All corrected photos are produced in JPEG 
format, and put into the same folder where Source Images are stored, with a "_DxO" suffix 
added to their name to distinguish them.  
  
But more sophisticated modes are at your disposal. They let you simultaneously generate, for 
each Source Image, a series of Output Images, in a variety of formats, into a variety of folders. 
Each image can thus be corrected into a TIFF version (for high-quality enlargements), a small 
JPEG (for a blog), an Adobe DNG format image (for subsequent processing), etc. 
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To explain these choices, we will first focus on the "Output settings panel"; then review the three 
possible output formats (TIFF, JPEG, DNG) and their settings; and finally describe how to 
launch the processing proper. 
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Output settings panel 
  

 
The output settings panel sets, for several output formats, their file type, destination folder, suffix to be 
added, image size and ICC profile 

  

About the Output settings panel 

The Output settings panel is displayed by default, and located on the left-hand side of the 
Process tab. This panel can be hidden / displayed by pressing a toggle button "Show [or hide] 
output settings panel",  located on the command bar of the Process tab. 
  
The purpose of the "Output settings panel" is to provide, for as many output formats as you 
want, the settings that will allow the software to generate these automatically. There is no limit 
to the number of output formats, as long as their names are kept different. So you will have to 
name them, for example, "JPEG HQ", "Poster print", "JPEG Medium"," JPEG web", "TIFF 
archiving", etc.  
  

The file formats and their constraints 
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Some image formats lose part of the information, to achieve a more compact size; these are 
referred to as "lossy". Others, which keep all the information available, while achieving a certain 
degree of compression, are referred to as "lossless". JPEG is a lossy format, while TIFF and 
most Raw formats are lossless. DNG (Digital NeGative, © Adobe) is a very specific format, 
designed by the software company Adobe to be a de facto norm for Raw files, which it has to 
some extent become. Technically, DNG files belong to the TIFF family. 
  
The possible relations between input and output formats are given by the following table: 

Input file formats Output file formats 

JPEG JPEG, TIFF (8-bit) 

TIFF  TIFF (8 or 16-bit depending on input) 

RAW  JPEG, TIFF (8 or 16-bit), DNG 

  

How to create an output setting 

  

To create a new output setting, click on the ―Create a new output setting‖ icon   above the 
―Output settings panel". You now will have to choose which type of existing output setting you 
want to use to build your new output setting.  
  
Some settings are specific to a file format; they are explained in the following sections, for 
JPEGs, TIFFs and DNGs. Other settings are common to all file formats (below): the choice of 
the output folder; the choice of a suffix for the filename; the choice of resizing parameters. 
  
Once you have made changes to an output setting, click on ―Save‖ to save your settings or 
―Cancel‖ to cancel your changes. If you want to delete an output setting, click on the ―recycle 
bin‖ to the right of the setting name. For an output setting to be active in the current processing 
session, it must be checked. 
  

Output folder 

 
The destination folder can be chosen either as the same folder as the original image, or as a folder of 
your choice 

  
By default, the output folder is the folder where the original image is stored. Checking the 
"Browse folder" button then pressing the "Browse for folder" icon will open a window and allow 
you to choose another folder (or to create one) in your computer‘s file system. You can also 
check the "browse folder" button, then type the name of the folder directly. Note that the file path 
can be absolute (like ―C:\Photos\Output DxO Optics Pro‖) or relative (―Output DxO Optics Pro‖). 
In the case of an absolute path, all the corrected images will be saved in a single folder even if 
the source images are split among distinct folders. In the case of a relative path, the corrected 
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images will be found in a sub-folder of the input folder, which helps keep the corrected images 
―close‖ to the source images; as many sub-folders will be created as there are source folders. 
  

Filename suffix 

By default, DxO Optics Pro appends ―_DxO‖ to any file name. You can replace this with any 
sequence of characters.  
  
Note: in certain cases, it is possible to have two Source images with the same filename but 
different extensions (e.g. Img34.jpg and Img34.CR2) This will be the case if you have shot in 
RAW + JPEG, which you can do with most cameras. During processing, the application will 
generate output images with the same name which will overwrite each other. To avoid this, one 
filename suffix will be appended for Raw images (e.g. “_raw”), and another suffix for JPEG 
images. This suffix policy can be set in the “Edit / Preferences / processing” menu. 
  

Changing size or resolution 

  

 
  
  
Changing the size of an image is the process known as "resampling", which needs a 
recalculation of the pixels that make up the image. In all cases, resampling must be performed 
at the latest possible stage, since it destroys a certain amount of information in your image. 
Therefore, if subsequent post-processing has to be done, we advise you to keep the initial 
dimensions. 
If you check this option, you will have to choose 4 parameters: 
  
● The largest dimension of the output image (whether height or width), in pixels, centimeters or 
inches. This single dimension is enough for the software to calculate from, as it maintains the 
aspect ratio (the proportions) of the image; 
  
● The resolution, generally expressed in dots-per-inch (dpi): 72 dpi for screen display, 254 dpi 
for a photographic printer (Kodak standard) or 300 dpi for publishing. If you are not changing the 
original size, we advise you not to alter the resolution either. 
  
● The mathematical method to be used for interpolation. Several options are available for 
interpolating (calculating mean values) for missing pixels: ―Auto‖ is a good choice, but many 
photographers are loyal supporters of bicubic interpolation, for optimum precision. 
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● The ICC profile (not available for DNG outputs) can be the original profile, or a choice 
between sRGB, AdobeRGB or a custom profile. In practice, the sRGB profile is well-suited for 
web publishing and for printing on photographic or ink-jet printers. The AdobeRGB profile will 
suit images that need retouching, e.g. for publication, but in this case a TIFF output is preferable 
to JPEG. A custom profile is a good choice for a printer for which you have an ICC profile 
stored. 
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Settings for JPEG files 
  

 
An output panel set to produce JPEG files of highest quality (index 96) with the default "_DxO" suffix. 

  
The JPEG format is designed for files that are going to be printed in photo processing labs, 
displayed online, or sent by e-mail. 
  
One specific option must be set when asking DxO Optics Pro to process JPEG files: the level of 
quality. A slider will allow you to set the degree of compression, hence quality loss, that you 
want, from 0 to 100. Of course, the higher the quality, the larger the output file. Since JPEG is a 
lossy format, we advise choosing higher quality (e.g. 90), and compensating if necessary by 
using a smaller image size. This is a better compromise than a larger image with a lower quality 
setting. 
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Settings for TIFF files 

 
  
  
The TIFF format is a lossless format, designed for high-quality files that you intend to archive or 
which will be further post-processed: all image editing applications are capable of importing 
TIFF images. 
  
When you ask for an output image in TIFF format, two specific settings must be decided: 
  
● The compressed / uncompressed option. We advise sticking with the uncompressed option, 
which of course results in a larger file, but is more widely accepted by post-processing programs 
than compressed TIFFs; 
  
● 8- or 16-bit encoding. 8-bit encoding provides only 255 possible levels per color channel, 
while 16-bit encoding provides 65,536 shades of color. This choice is of course only available if 
the source image itself was originally coded in 16-bit format (i.e. was in Raw or 16-bit TIFF 
format). We advise choosing the 16-bit format whenever possible, since it greatly improves color 
rendition: even though there are currently a few programs and printers that are unable to 
process 16-bit TIFFs, this format does represent a superior solution for archiving and preserves 
the future of your images, even if for the moment you may not necessarily be able to take full 
advantage of all the information they contain. 
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Settings for DNG files 
  
The DNG format is designed for files you intend to archive or that are going to undergo further 
post-processing with DNG-compatible software such as Adobe Camera Raw /Photoshop 
/Lightroom. 
  
The DNG generated by DxO Optics Pro is a 16-bit linear DNG format. This format is only 
available for original images in Raw format. No quality option is offered. Linear DNG means that 
the three color channels have been calculated and therefore that the file is three times larger 
than the original Raw file. This format offers the same level of color and exposure control as 
with a Raw file generated by the camera. 
  
For the other options you can treat DNG files in the same way as TIFF files, except for image 
size, as files intended for archiving and/or further post-processing should not be resized, in 
order to maintain maximum potential in the future. 
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Launching the processing 
  

 
Launching the processing opens this window, to ask if the whole project, or only selected images, are to 
be processed 

  
Before launching the processing, you must check the box(es) to enable the desired output 
setting(s) (even if you have just created or modified it, an output setting will remain inactive 
unless you check its box). You must check at least one setting, and you can check as many as 
you want. This is a powerful feature of DxO Optics Pro, since it allows several output images to 
be processed from one source image all at the same time.  
  
Tip: Output settings can be used to automatically create back-ups of each image on several 
hard disks or servers. All you have to do is define several output formats that are identical, 
except for the folders in which the processed images are going to be saved. 
  

To start processing, click the   button. A dialog box will open to ask whether 
you want to process the whole Project or only the selected images. You can also start 
processing by selecting one or more images, then dragging them into the ―PROCESSING‖ 
pane. 
  
If there are images in the destination folder that have already been corrected by DxO Optics Pro 
(e.g. in an earlier Project) and are already using the same name as an image to be processed, 
the program will ask you if you want to overwrite the previous version(s). If you answer no, the 
image will not be processed. 
  
While processing is in progress (this can take quite some time if there are many photos or the 
files are large) gearwheels will be displayed over the thumbnails that are being processed.  
  
Once processing is completed, the ‗blue star‘ icon on each thumbnail becomes a green tick, 
indicating that processing has been successful for that image. If an error has occurred, an ―!‖ will 
be displayed. 
  
If you feel that DxO Optics Pro is not using all your system resources fully and is too slow, you 
can adjust — from two, which is the default — the number of images which the program 
processes simultaneously (in the menu Edit > Preferences > Process).  
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Attention: DxO Optics Pro is multi-thread and will use all your processor's cores to work on one 
(or more) images. But if you increase the number of pictures, make sure you have enough 
RAM, otherwise the gain due to multi-threading will be offset by the memory swapping process 
between Ram and disk. 
  



DxO Optics Pro v6.6 User Manual - Windows 

116 

Step 4- the View tab 

About the View tab 
  
Once processing is complete, the "View" tab allows you to thoroughly assess the quality of the 
corrected image: what you now see is no longer a simulated correction, but the definitive copy. 
  
The main advantage of using this step to examine your images is that you can easily go back to 
the "Customize" tab and modify an already corrected and processed image. Of course the 
processed image itself can no longer be changed. But a newer corrected image can be created 
and processed. Whether it will overwrite the older corrected image or coexist with it is up to you. 
To allow both images to coexist, all you have to do is create Virtual copies.  
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View tab commands 
  

 
Left–right: navigating between various output copies; display of a single or dual image; the Pointer tools; 
the Scale tools; the Zoom slider.  

  
From left to right, the "View" tab command bar contains the following groups of icons: 
  
● The "Up" and "Down" arrows let you navigate between the various output copies of a single 
original (e.g. one JPEG high-quality, one JPEG medium quality, one TIFF full size, etc.) 
  

● The three display icons . The "Single image display" icon (left) displays the actual 
corrected image; clicking on this image (or keyboard shortcut Ctrl-D) lets you toggle the display 
between the corrected image and the "Reference Image". The "Dual image display" (center) 
displays the corrected image and the reference image side by side. The drop-down menu (on 
the right) lets you decide which image will be the "Reference image". Most of time, of course, it 
will be the uncorrected image. But if you create "Virtual Copies" of an image, you might use one 
of these copies as a "Reference Image" in order to better appreciate the effect of various 
different corrections. Once processed, Virtual copies will be listed in this menu, and so you just 
need to click on one of them. 
  

● The ordinary Pointer tool , when active, and when the ―Single image display‖ mode is 
enabled, is used to toggle between the output image and the reference image, simply by 
clicking on the reference image or releasing the mouse button (Ctrl-D produces the same 

effect). The Hand tool  can be used to move the visible area of the image. The Magnifying 

glass , when clicked over the image, allows you to magnify it up to a factor of 1600%.  
  

● The zoom slider  lets you adjust the display scale 
between 2% and 1600%. The first two sub-icons are used: (1) for a fit-to-screen display; and (2) 
for a 100% (or 1:1 scale) display. The drop-down menu is used to quickly reach a number of 
commonly-used display scales (five choices, from 25 to 400%) or type in a desired 
magnification factor. Last, the slider (display scales from 2% to 1600%) allows rapid zoom in or 
out.  
  
Tip: if your mouse has a scroll wheel, this will be the fastest way to zoom in and out on the 
image. 
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What's next  
  
Once you have viewed your processed images, there are a number of tasks that you might want 
to perform before quitting DxO Optics pro . For a reminder of these tasks, click the "What is 
next?" button at the far right of the project pane (This button is only visible, when the first step 
assistant is active) to pop up a help screen that describes all the possible options listed below: 
  

Modify corrections on some images 

If some images need other corrections, click at the top of the main window on the ―Customize‖ 
tab. When the images are re-processed with modified corrections, the new output images will 
overwrite the previously-corrected versions, unless you first give them new names. (A dialog 
box in the Process tab will ask you if you are sure that you want to overwrite). 
To avoid overwriting previously corrected images, you could use Virtual Copies, which let you 
generate as many distinctly corrected versions of a single image as you want. You can create a 
Virtual Copy by right-clicking on a thumbnail in the PROJECT pane.  
  

Export images to Lightroom or Flickr 

Select the images to export in the PROJECT pane. Click on the Lightroom (Lr) or Flickr icons in 
this pane‘s icon bar  and follow the instructions. 
  

Open the processed images with another application 

In the ―PROJECT‖ pane, select the images you want to export, then select the menu command 
"Image" > "Open with", and select the application you want to use. You can widen the choice of 
applications by selecting them with the ―Browse‖ button and choosing a program name to run 
from your list of photo editing applications or from a shortcut on your desktop. 
  

Process images that were not processed 

If some of your images have not yet been processed, for example if you wanted to check the 
results of applying a preset before deciding to apply it to a whole batch, simply go back to the 
Process tab and click on ―Start processing‖, which will launch processing for all unprocessed 
images.  
  

Start a new project 

Go back to the ―Select‖ tab. Click on ―New Project‖ in the File menu. The details of the current 
project will be automatically saved in the DxO Optics Pro database, and a new Project will be 
created. 
  
 ...and finally: 
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Exit DxO Optics Pro 

Click on ―Exit‖ in the File menu to quit DxO Optics Pro. The details of the  current project will be 
automatically saved in the DxO Optics Pro database. 
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The main concepts used by DxO Optics Pro 

  
  
About DxO Optics Pro.- DxO Optics Pro is a software which automatically corrects the defects 
of a photographic image. These can derive from the camera, from the lens, or simply from the 
scene which has been shot: e.g. poor lighting conditions. In addition, DxO Optics Pro offers a 
series of tools which allow the photographer to fine-tune his images to his personal tastes.  
  
Auto mode.- Certain settings position themselves, without the user having to intervene, on an 
optimal value in terms of image quality. They are said to function in ―Auto mode‖. These settings 
can in all cases be switched to manual mode by the user. Depending on the correction to which 
the setting is related, the automatism is based on one of those mechanisms: 
- Automatism based on camera calibration data (an update is necessary for a newly supported 
camera); 
- Automatism based on lens - camera combination calibration data: (the downloading of a DxO 
Optics modules is necessary for a newly supported combination, in addition to a software 
update if the camera itself is newly supported).  
- Automatism based on the image content: this is the case with auto-exposure correction, or 
DxO Lighting correction. 
- Automatism based on interactions between settings: this is the case when an automatic 
cropping comes after perspective corrections.  
When all the settings related to a correction are in Auto mode, this correction itself will be said 
as being ―in auto mode‖, in which case the word ―Auto‖ will display at the right of the name of 
the corresponding sub-palette.  
  
Calibration.- A detailed measurement of the specific defects of images, whether due to the 
camera or to the lens, in given shooting conditions. Those data have been measured by our 
laboratories. They are the foundations upon which stand most of the automatic corrections of 
the software. 
- Camera calibration: gives, depending on shooting conditions, a measurement of noise (Raw 
and JPEG images); and of color rendering (Raw images). Those camera calibration data are 
stored in the software.  
- Lens-camera combination calibration: gives, according to shooting conditions, a measurement 
of the defects of a given lens on a given camera. Those data are stored in files named ―DxO 
optical modules‖.  
 - Film pack calibration : measurement of the color rendering of a film. 
  
Correction.- Any action by the software, aiming at raising the quality of the source image in a 
given field (e.g. ―distortion correction‖). The raw conversion is considered as a correction. A 
correction depends on settings, which are grouped, on screen, in a sub-palette.  
  
Default preset.- A full preset, which by default is associated with any new source image added 
to a project. The DxO default preset is considered as providing an optimal correction for most of 
the images. 
  
DxO Optics Module.- A DxO Optics Module is a file which stores the calibration data of a given 
lens-camera combination. It allows DxO Optics pro to automatically correct the optical defects 
due to the lens. See also DxO Optic module ambiguity, and DxO Optics module status.  
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Full preset.-A preset which contains all the settings of the settings stack. 
  
HDR (High dynamic range).-  HDR images are a particular case of merged images, in which 
the images used for merging (generally 3 or 5) are bracketed each side of the normal exposure. 
This results in considerably accrued details both in shadows and highlights.  
  
Manual mode.- Certain settings must be activated by the user to produce an effect onto the 
image: either because no Auto mode is available with this setting; or because the user has 
chosen to deactivate the Auto mode and shift to Manual. In both cases we will speak of ―Manual 
mode‖.  
  
Merged image.- Merging images consists, from several shootings of an unchanged subject, in 
mixing them to enhance the quality of the final (merged) image. When the various shootings are 
bracketed above and under the correct exposition (generally 1 or 2 on each side), the merged 
image is called an HDR (High Dynamic Range) image. It benefits not only from accrued details 
in shadows and highlights, but also from a strongly reduced level of noise. And when the 
various shootings are made with the same exposure, the merged image only results in a strong 
reduction of noise. 
In both cases, the several identical images used as input, as well as the resulting merged 
image, are of the Raw type. The merged image can be post-processed like any ordinary  Raw 
image, and can be applied presets as well. 
  
Merging reference image.- In the image merging process (whether this process is used to 
make a High dynamic range image or to simply de-noise an image), it is necessary to suppress 
ghosts which have been created by subjects having moved between one of the successive 
shootings. The merging reference image is, among all those to be fusioned, the one where no 
removing of ghosts will take place. 
  
Output image.- The final image created by DxO Optics Pro and saved on the disk, by applying 
to a source image the corrections listed in a settings stack. The output image is in all cases a 
new file with a different name from the source image. 
  
Palette.- (Generally) An expandable / collapsible zone containing several sub-palettes 
correcting relatively similar defects. Ex.: the Light palette, the Detail palette. (By analogy) An 
expandable / collapsible zone which is not used to contain corrections, but contain informative 
or editing tools: 
- The Zoom palette allows to zoom in or out of the image, and to move the image in the display 
window; 
- The Histogram palette displays information about the distribution of color and luminance levels 
inside the image; 
- The EXIF palette gives access to the EXIF data of the image.  
- The Preset palette allows to create and edit Presets (for advanced users).  
  
Partial preset.- A preset which contains a limited subset of the settings of the settings stack. 
  
Preset.- A collection of predefined settings, stored by the software, which can be applied on 
demand to any image. A preset can contain all the corrections of the settings stack (full  preset) 
or only a fraction of them (partial preset).  
Applying a full preset to an image amounts to replacing all the setting stack of this image by 
what is contained is the preset.  
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Applying a partial preset to an image amounts to replacing only a part of the settings stack by 
the preset. In which case, the user can decide that the settings which are not affected by the 
superimposed partial preset can be (1) kept as they are; or (2) replaced by the settings 
contained in the DxO default preset. 
Note: At any moment it is possible to save the current settings stack as a full preset.  
  
Preview.- Depending on the current stage, ―Preview‖ can have some slightly different 
meanings: 
- In the Select tab, the preview of an image displays it in a large format, helping you decide 
whether to include it into a project.  
- In the Adjust tab, the preview is an image which simulates the corrections which will be applied 
to the source image. These corrections are calculated only for the section of the image 
effectively displayed on the screen. Moreover, in the same purpose of making the display faster, 
certain corrections, which cannot be perceived with a magnifying factor of less than 75%, are 
not applied. It is therefore necessary, to judge these corrections (e.g. noise) to ask for a 
magnifying factor of more than 75%.  
  
Processing.- the action of effectively applying all the corrections listed in the settings stack to 
an image in the project, and of saving the result, which then will be named an output image. 
Remember that at no moment the source image will be modified, and that the output image is in 
all cases a new file with a different name. 
  
Project. - A collection of source images, each accompanied by its complete setting stack. 
  
  
Reference image.- The term reference image is used in the Adjust tab and the View tab. By 
default, the reference image is the Source image (in the case of a raw image, this Source image 
is minimally converted to make it readable).  But the reference image can be changed, on 
demand, to another Virtual copy of the same Source image, on condition that this virtual copy 
has already been processed.  
When in the Adjust tab, the Reference image is compared to a simulated view of the not-yet 
processed image. in the View tab, it is compared to the real Output image.  
The term Reference image is also used in the more specific expression of Merging reference 
image (see below). 
  
Setting.- A setting is the, or one of the, parameters of a correction. A correction is configurable 
thanks to one or several settings.  
  

- Some settings work in Auto mode (which can be switched to manual on user‘s demand), 
and we will speak of ―Auto mode‖; while others only work in manual mode, and we will 
speak of ―Manual mode‖. A variety of tools can be used to modify a setting :  

-- sliding a cursor; 
-- typing a numerical value; 
-- clicking in a drop-down menu; 
-- using a specialized tool (e.g. a pointer); 
-- dragging on a curve to modify its shape. 
  

- Some settings (and hence the corrections associated to these settings) can be 
unavailable in certain circumstances: 

-- available for Raw or for JPEG images only; 
-- unavailable because the camera is unsupported;  
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-- unavailable because the lens-camera combination is unsupported;  
-- ineffective because the EXIF data are missing; 
-- unavailable because the optional software module DxO FilmPack has not been 
installed. 

  
Settings stack.- The setting stack of an image is the list of all the corrections available in the 
software, each correction being accompanied by its status for this image (―active‖ or ―inactive‖), 
and if active by the chosen values for all available settings. 
  
Source image.- Applies to any image which enters the DxO Optics Pro processing. Can be a 
Raw or JPEG image. Raw images are preferable since they retain a much larger quantity of 
original information.  
  
Sub-palette.- An expandable / collapsible zone, containing all the settings relative to a given 
correction. Each correction has its sub-palette. 
  
Supported camera.- A camera is said to be ―supported‖ when the software has access to its 
calibration data.  
  
Supported lens-camera combination.- A lens-camera combination is said to be ―supported‖ 
when the software has access to its calibration data. 
  
Tabs.- The four ―tabs‖, in DxO Optics Pro, are the four panels which appear superimposed on 
the screen, and which constitute the four divisions of the treatment. The user can at any 
moment click on one of the tabs to make it active: 
– The Select tab is the mandatory first step of the global process. It allows to select ―Input 
images‖, and results in the making of a ―Project‖.  
– The Adjust tab is an optional step. It allows to fine-tune the settings of the corrections which 
will be applied to input images.  
– The Process tab applies the effective corrections treatment to an input image or a batch of 
input images.  
– The View tab is an optional step. It allows to visualize in detail the output images, and if 
needed to export them towards other applications.  
  
Tool. A pointing device which can be used to control a setting or to modify the image display: 

- when used to control a setting, the tool will be called a ―setting tool‖: 
-- the cropping tool; 
-- the dust removal tool; 
-- the horizon tool; 
-- the Force parallels tool; 
-- the Rectangle tool; 
-- The Multipoint balance tool; 
-- the White balance pipette;  

- when used to change the display of the active image, the tool will be called a 
vizualisation tool: 

-- the magnifying glass tool (to zoom in and out);  
-- the hand tool (to move the image in the display window); 
-- the arrow tool, which when clicked shifts from the reference image to the 
previsualized image (Adjust tab) or the processed image (View tab).  
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Virtual copy.- Inside a project, a Virtual copy is a duplicate of a source image with a distinct 
Settings stack. The purpose of creating a Virtual copy is to test two set of corrections : one on 
the Source image itself, another on the Virtual copy. Multiple Virtual copies of the same Source 
image can be created, each with a distinct Settings stack.  
  
Note : as well as the Source image is not really copied into the project but only linked to it, as 
well a Virtual copy is no real duplicate, but a second link to the same Source image. 
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Menus 

File menu 
  

 
  
● New project – creates a new DxO Optics Pro Project. 
● Open project – opens a Project from the database of DxO Optics Pro Projects. 
● Save project – saves the Project to the DxO Optics Project database. 
● Rename project 
  
● Recent projects – directly accesses the recently created Projects 
  
● Project Database – allows you (1) to create a backup, (2) restore a backup and (3) import a v5 
project database. The save function lets you copy the Project database to another disk. 
● Delete all projects – will remove all previous Projects from the DxO Project database. 
  
● Export image for ICC profile – saves images which can be used by professional calibration 
programs to create ICC profiles (linear RAW or realistic color rendering options available).  
  
● Sidecars – exports and imports the current project ―sidecar‖ (the individual settings file for 
each image) in .dxo format. Sidecars allow you to transfer all correction settings of an image 
from one computer to another or share them with other users. 
  
● Exit – leaves DxO Optics Pro. The current Project is saved automatically when you exit the 
program 
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Edit menu 

 
  
● Undo [Ctrl + Z] and Redo [Ctrl + Y] apply to the last action you performed. 
  
● Cut [Ctrl + X] – lets you cut out selected text or objects from their current location and puts 
them into the system clipboard. 
● Copy [Ctrl + C] – lets you copy selected text or objects from their current location and places 
them into  the system clipboard. The original text or objects remain at their current location (e.g. 
Exif data). 
● Paste [Ctrl + V] – lets you copy the content of the system clipboard to the current cursor 
position (for example, personal details to be added into the image Exif field). 
● Select all (Ctrl + A) – lets you select all the images in a folder in the ―Select‖ tab to add them 
to the Project. 
  
● Refresh (F5) updates the contents of all visible folders. 
  
● Preferences (Ctrl >+ Shift + P) lets you make adjustments to certain overall program working 
parameters. Full details for all the Preferences options are listed in the next section.  
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Preferences 

Preferences - The "General" tab 

  

 
  
● Enables or disables ―Play sound at startup‖. 
  
● DxO Optics Pro automatically checks for updates at startup.  
  
● The application loads the last project at startup. 
  
● Shows the "Welcome screen" at startup. 
  
● Saves image settings in a ―sidecar‖ file automatically: sidecar files are small text files, with a 
".dxo" suffix, associated with image files;  they contain all the information needed to correct an 
image; in this way, if you want to copy your image on another computer, you should copy not 
only the image, but also its sidecar file. It would also be advisable (see the check immediately 
below) to have the sidecar file automatically loaded with the image when the latter opens on the 
other computer. Alternatively, you can manually load sidecars via the "File/Sidecars/Import" 
menu. 
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● Automatically loads the settings of an image from a ―sidecar‖ file, and associates it with the 
image when it is added to a project. 
  
● Sets the number of images per project (500 by default); 
  
● Use legacy (v6.2 and earlier) RAW color handling for DxO Lighting 
Up to version 6.2, when opening shadows with DxO Lighting, DxO Optics Pro had a tendency to 
increase color saturation. Version 6.5 handles saturation more precisely but this change affects 
how previously-created presets will render images. Checking this box will cause DxO Lighting 
behavior to revert to version 6.2 and thereby maintain consistent saturation for previously-
created presets. 
  
● In case of problem with the software, send / don‘t send (the default is ―send‖) information to 
DxO technical support to help solve the problem. 
  
● Agreement to participate to an anonymous program of product improvement by DxO. This 
program sends to DxO Labs a limited set of technical data about your system‘s configuration 
and about your DxO projects. They allow DxO to enhance its products and improve your 
experience. The detailed list of these data is available by clicking here. 
  
● Autosaves the current project. 
  
  
About sidecars: the Project database contains all the settings for the images in saved projects. 
These settings can be exported in the form of “sidecars” that can then be shared with other 
users so that the exact settings for the image in question can be reused on another computer. 
Automatically saving a sidecar therefore allows you to create a file “image 1.dxo” for the 
corresponding image (“image1.JPG”) that contains all the settings for this image. The image 
and its corresponding .dxo file can then be copied onto another computer. If the “Load settings 
from sidecar file automatically” option has been enabled in the version of DxO Optics Pro 
installed on that computer, the sidecar will be automatically associated with this image when it is 
added to a project. 
  

http://help.dxo.com/faq/index.php?action=artikel&cat=1151&id=115115&lang=en
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Preferences - The "Process" tab 

  

 
● In certain cases, you could have two source images with the same filename but different 
extensions. For example, when you shoot Raw, many cameras generate not only the Raw 
image, but also a Jpeg of the same name, e.g. myimage.cr2 and myimage.jpg.  During 
processing, the application will generate output images with the same name, which will 
overwrite each other. To avoid this, you should either add a filename suffix for the Raw images 
(e.g. ―_raw‖), or a filename suffix for the Jpeg images. This suffix will only be appended in the 
event of the conflict described above. 
  
● Tab browsing during processing can be allowed or forbidden (it is recommended you leave 
this unchecked, as it can slow down processing). 
  
● Ticking this checkbow allows the application to process your RAW images while using 
metadata which were previously stored in a file of the xmp format, stored alongside the input 
image (e.g. metadata created by a software like "Adobe Bridge"). 
  
● Number of images processed simultaneously: whatever the memory (Ram) and the number of 
processors on your system, DxO Optics Pro uses all those available, and sets a 
"recommended" number of images to be treated simultaneously.   It is recommended that you 
do not change the default setting. If you change this setting though (e.g. to a lower value, 
allowing other applications to work simultaneously), you'd have to restart DxO Optics Pro for the 
change to be taken into account. 
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Preferences - The "Display" tab 

  

 
The "Display" tab is made of three parts: choices which are common to different stages of the application 
("Common"); others which are specific to the "Customize" tab or the "Project" pane. 

  
First part : "Common" preferences 
Three lines let you enable or disable important settings: 
  
● The first determines whether the image is displayed blinking front/back in the ―Image‖ pane 
when you enter the ―Customize‖ tab. Unchecking the box removes the blinking; 
  
● The ―Display DxO Optics Module download window‖ lets you see the DxO Optics Module 
download window as soon as you add an image to the project for which a module is available 
but has not been installed on your computer 
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● "Display the Presets dialog box": when you apply a Preset to an image you can choose to 
superimpose the preset either to the settings already associated with the image or to the DxO 
Default v2 preset. The dialog box that appears at this point allows you to make this choice;. 
  
The following choices are self-explaining. They enable / disable the showing of informative 
windows. 
  
Second part: "Customize" tab 
● The background of the ―IMAGE‖ pane, in the ―Customize‖ and ―Views‖ tab, can be adjusted to 
a lighter or darker gray (the scale runs from black to white); 
  
● The size of the grid mesh (which can be positioned over the image to check for distortion or 
keystoning) can be fine-tuned; 
  
● Tools in the ―Tools‖ palette can be shown permanently in the command bar in the ―Customize‖ 
tab (this allows you to hide the ―Tools‖ palette from the side of the workspace). 
  
● (for Windows users only) this choice allows you to enter the ICC profile of your screen with 
three options: 
– the specific ICC profile of your screen, if you have calibrated it with a colorimeter; 
– the sRGB color profile (use this if in doubt). If your screen has not been calibrated, this is 
probably the best profile to use as most screens leave the factory configured close to sRGB 
settings. 
– Adobe RGB: only use this profile with a high-quality screen, of which you know the specific 
Adobe RGB gamut. 
  
● The display can be accelerated by the Graphic card (GPU); this control should be disabled if it 
causes the display to be unstable. 
  
Third part: "PROJECT" pane 
● You can enable or disable the image stacking option, which allows you to apply the same 
processing to a batch of images. The photo on the top of the stack (when the stack is collapsed) 
is the one on which you will adjust your settings; 
  
● You can also enable or disable the ―Next step‖ assistant, which lets you move to the next step 
by simply clicking on the command to the right of the top bar in the ―Project‖ pane. 
  
● A warning icon   can be displayed / disabled when an image is opened ("disabled" is the 
default status), in case of insufficient information provided by the EXIF data: 
- a focusing distance ambiguity can be resolved by typing this distance in the ―Focusing 
distance‖ sub-palette which will display in the ―Geometry‖ palette; 
- a focal length ambiguity can be resolved by setting a slider which will fine-tune the focal length 
shown in the Exif data  This slider can be found in the ―Focal length‖ sub-palette which will 
display in the ―Geometry‖ palette. 
  
● Eight sort of icons concerning each thumbnail can be displayed ("always on") / disabled 
("always off") / displayed only on hovering ("on mouseover"): 
- the image processing status: waiting for processing or processed ; 
- the file name, showing whether the image is a Raw or JPEG file 
- red/yellow/green lights to show which images are to be processed or not  (see details). 



DxO Optics Pro v6.6 User Manual - Windows 

132 

- stars to rate your images and rank them by quality (see details).  
- whether or not a DxO Optics Module is available or not (see details).  
- "information missing" icon that is displayed when EXIF data is missing or unprecise and that 
the corresponding boxes have been checked (see above). 
- buttons for rotating the photo to the left or right. 
- the ―recycle bin‖ is used to remove the current image from the Project; note that the original 
image itself is never deleted: DxO Optics Pro only manipulates shortcuts to images, not the 
images themselves. 
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Project menu 

 
  
The Project menu helps you to manage your Project as effectively as possible; with some 
commands are also accessible by clicking on an icon. 
● Project properties – displays the various characteristics (number of images, date, star ranking) 
of the current open Project. 
  
● Start Processing – starts processing the Project immediately.  
  
● Sort – lets you sort the images in the "PROJECT" pane in the order you want (file name is the 
basic default criterion): other options include Raw format images, processed images, name, 
size, date, dimensions, etc. 
  
● Filter – displays in the ―PROJECT‖ pane only those images which fit the filter criteria.  
  
● Stack (only active if the option "Stack images" has been checked  under your general 
preferences). 
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View menu 

 
  
The View menu lets you navigate between tabs and controls how images are displayed in the 
―Select‖ tab. 
  
Note: Some of the commands in the following list can be active or inactive depending which of 
the four tabs you are working in. 
  
– The top-most dialogue box lets you choose between the four tabs: Select, Customize, 
Process and View. 
  
– The lower dialogue box controls the ―Select‖ tab and is disabled if you are working in another 
tab: 
  
● Image browser – lets you select the source of your images: the computer file system, the DxO 
project database or the Lightroom database if this application is installed on your computer. 
● Display images from selected files either as list or as thumbnails. 
● Sort – selects criteria for sorting images in the ―Select‖ tab. 
● Filter – selects criteria for filtering images in the ―Select‖ tab. 
● "Unlock Project window" or "Dock Project window" determines whether the ―PROJECT‖ pane 
is docked at the bottom of the screen or floating. 
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Image menu 

 
  
● Image properties – shows the EXIF data for the current image. 
● Apply a preset – select a Preset from the drop down menu; 
● Create preset from current settings – creates a Preset based on the current settings for the 
selected image. 
● Copy correction settings – used to reuse the settings of  the current image to apply them to 
another image or stack. 
● Paste correction settings – once you have selected a new image, pastes the settings that you 
have previously copied. 
  
● Rotation – to rotate the image 90° left or right. 
● Remove from project – removes the selected image(s) from the Project; this does not delete 
Source Images from your hard disk. 
● Show input file in Windows Explorer – lets you view the location of the folder of the selected 
Source Image 
● Show output file(s) in Windows Explorer – lets you view the location of the folder of the 
selected Output Image 
● Open input image (resp. output image) with – allows you to open Source Images (resp. output 
images)  in another post-processing application, for example to print it for checking. The first 
time you use the program, you will see a ―Browse‖ command and can then choose the shortcut 
for the post-processing application that you want to use. 
  
● Create Virtual Copy – When correcting an image, you often apply different settings 
successively. Of course, each time new settings are applied, the previous settings are canceled 
and their effect on the image is not memorized. It is precisely to keep a trace of these 
successive settings that you can use "Virtual Copies". Each time you create a "Virtual Copy" of 
the same reference image, this copy is accompanied by its personal set of correction settings. 
Thus, different sets of corrections can be precisely compared one against each other. Clicking 
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on "Create virtual copy" opens a dialog box, asking whether the selected image must 
accompanied by the present correction settings (the effect of which is visible on the screen), or 
by a stored setting (preset). 
● Allow Processing 
● Ranking – allows you to rank images by quality using a star-rating system. Only visible if the 
―Ranking stars‖ option has been activated in preferences 
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DxO Optics modules menu 
  

 
  
You can use this menu to manage the DxO Optics Modules required for fully automated 
processing of your images: 
  

 Install new DxO Optics Modules – connects you to the Internet to choose a new module. 
This module will be operational as soon as it has finished loading. 

 DxO Optics Modules – displays the list of modules already installed and lets you 
uninstall them (except for the used Module). 

 DxO Optics Module ambiguity – if the EXIF data for the image do not enable DxO Optics 
Pro determine which module to use for lenses that have the same characteristics (but 
are not the same brand, for example), a dialogue box opens so you can choose which 
module to use either just for the current image or more generally. 

 Modules roadmap – connects you to the DxO Labs website, where you can see which 
modules are due to be released soon 

 Suggest a DxO Optics Module to DxO Labs – connects you to the DxO Labs website, 
where you can suggest a DxO Optics Module you would like to be produced. 
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Help menu 

 
  
The Help menu offers a number of aids to help you use DxO Optics Pro more effectively. The 
options are: 

 First steps wizard – shows an introductory screen for each tab. 
 Welcome screen – displays the application welcome screen. 
 Check for update… – (active Internet connection required) When you click on this menu 

item, the program will connect to the DxO Labs server to determine if you have installed 
the most recent version of DxO Optics Pro. If this is not the case, you can download and 
install the latest update. 

 Software license – (administrator authorization required with some operating systems) 
allows you to activate the software and activate the optional DxO FilmPack module. An 
active Internet connection is recommended at this point, so that you can enter your 
activation code when asked.  

 Help –  launches the local help. 
 Shortcuts – displays a list of keyboard shortcuts 
 Visit web site – [active Internet connection required] Clicking on this menu option 

launches your default web browser and connects you to the home page of the DxO Labs 
web site. 

 About DxO Optics Pro… – Select this menu option to view the "About DxO Optics Pro" 
window where you will find information about the version you are using and any add-ons 
currently installed. This information is especially useful if you need to contact DxO Labs 
technical support. 
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Right-clicking on thumbnails in the “Project” pane 
  
Right-clicking on an image or a stack in the "Project" pane brings up a context menu whose 
commands are exactly the same as the commands in "Image" menu:  
  

 
  
Note: Some of the commands in the following list can be active or inactive depending which of 
the four tabs you are working in. 
  
  
● Image properties – shows the EXIF data for the current image. 
● Apply a preset – select a Preset from the dropdown menu; this can either be applied in 
addition to current settings or in addition to the "DxO default v2" Preset: see details.  
● Create preset from current settings – creates a Preset based on the current settings for the 
selected image. 
● Copy correction settings – used to reuse the settings of  the current image to apply them to 
another image or stack. 
● Paste correction settings – once you have selected a new image, pastes the settings that you 
have previously copied. 
  
● Rotation – to rotate the image 90° left or right. 
● Remove from project – removes the selected image(s) from the Project; this does not delete 
the original images. 
  
● Show input file in Windows Explorer – lets you view the location of the folder of the selected 
Source Image 
● Show output file(s) in Windows Explorer – lets you view the location of the folder of the 
selected Output Image 
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● Open input image (resp. output image) with – allows you to open Source Images (resp. output 
images)  in another post-processing application, for example to print it for checking. The first 
time you use the program, you will see a ―Browse‖ command and can then choose the shortcut 
for the post-processing application that you want to use. 
  
● Create virtual copy – Allows to create, from a same reference image, different "copies" which 
have been corrected by different set of corrections or different presets. (More details) 
● Stack: allows the creation of a stack of images (More details).  
● Flag – Uses the system of red, yellow and green lights that can be shown on a thumbnail (a 
red light prevents the image from being processed). Only visible if the ―Red/yellow/green lights‖ 
option has been activated in preferences 
● Ranking – allows you to rank images by quality using a star-rating system. Only visible if the 
―Ranking stars‖ option has been activated in preferences 
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DxO Optics Pro and Lightroom 

  
  

Working with Adobe Lightroom 

  
Adobe Lightroom has become a reference in the photographer‘s workflow. Our goal is to 
optimize your workflow and provide you with added value by making DxO Optics Pro work with 
Lightroom.  
A PDF describing the three possible working scenarios between DxO Optics Pro and Lightroom 
can be downloaded from  
  
http://www.dxo.com/intl/photo/support/User_Guides.  

http://www.dxo.com/intl/photo/support/User_Guides
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Windows shortcuts 

  

General   

New project CTRL + N 

Open project CTRL + O 

Rename project SHIFT + F2 

Save project CTRL + S 

Quit ALT+F4 

Copy (text fields) CTRL + C 

Cut (text fields) CTRL + X 

Paste (text fields) CTRL + V 

Select all CTRL + A 

Undo CTRL + Z 

Redo CTRL + Y 

Dock/Undock the ‗PROJECT‘ pane CTRL + U 

Go to « Select » tab CTRL + F1 

Go to « Customize » tab CTRL + F2 

Go to « Process » tab CTRL + F3 

Go to « View » tab CTRL + F4 

Display preferences window CTRL + SHIFT + P 

Full screen mode ALT + ENT 

Hide/Unhide the ‗PROJECT‘ pane CTRL + F9 

Help F1 

    

Project pane   

Copy correction settings CTRL + SHIFT + C 

Paste correction settings CTRL + SHIFT + V 

Go to previous image  

Go to next image  

Rotate image selection by 90° left CTRL +  
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Rotate image selection by 90° right CTRL +  

Create virtual copy CTRL + I 

Ranking CTRL + (0, 1, 2, 3, 4, 5) 

Add to stack (or create stack) drag & drop 

Start processing CTRL + K 

Image properties CTRL + J 

Project properties CTRL + E 

Remove image from project Del 

Delete image from filesystem (move to trash) Ctrl-Del 

Reveal in file system Ctrl-R 

    

« Select » tab   

Hide / Unhide the "BROWSE" pane CTRL + F10 

Display file system SHIFT + F9 

Display project database SHIFT + F10 

Display Lightroom catalog SHIFT + F11 

List mode/Thumbnail Toggle CTRL + M 

Display preview window Space Bar 

Add selection to Project Double click 

    

« Customize » tab   

Display the reference image (hold key) click 

Hand Tool (hold key) Space Bar 

Display corrected and original image side by side or front/back CTRL + T 

Hide/Unhide all palettes F9 

Fit on screen F2 

Zoom to 100% F3 

Zoom out CTRL + Add 

Zoom in CTRL + Substract 

Toggle Grid overlay CTRL + G 

Toggle Information overlay CTRL + H 
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Overlay Clip to white CTRL + W 

Overlay Clip to black CTRL + B 

    

« View » tab   

Display corrected and original image side by side or front/back CTRL + T 

Fit on screen F2 

Zoom to 100% F3 

Zoom out CTRL + Add 

Zoom in CTRL + Substract 

    

Tools   

Move active slider (made active by clicking on it) 
 and  (left and right 
arrows) 
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